<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Administration Console</td>
<td>68</td>
</tr>
<tr>
<td>Import license files</td>
<td>70</td>
</tr>
<tr>
<td>Change port numbers</td>
<td>71</td>
</tr>
<tr>
<td>Change the default and display language</td>
<td>73</td>
</tr>
<tr>
<td>Improve performance by specifying thread use</td>
<td>74</td>
</tr>
<tr>
<td>License administration</td>
<td>75</td>
</tr>
<tr>
<td>Monitor licenses and alerts</td>
<td>76</td>
</tr>
<tr>
<td>Security</td>
<td>79</td>
</tr>
<tr>
<td>System information, logs, and alerts</td>
<td>80</td>
</tr>
<tr>
<td>License Server administration without a console</td>
<td>84</td>
</tr>
<tr>
<td>Use Manage Licenses in My Account on citrix.com</td>
<td>87</td>
</tr>
<tr>
<td>Licensing commands</td>
<td>91</td>
</tr>
<tr>
<td>Clustered License Servers</td>
<td>103</td>
</tr>
<tr>
<td>Clustered License Servers - install, upgrade, and uninstall</td>
<td>108</td>
</tr>
<tr>
<td>License Server back up and redundancy</td>
<td>110</td>
</tr>
<tr>
<td>Troubleshoot the License Server</td>
<td>111</td>
</tr>
</tbody>
</table>
September 18, 2019

**Important:**

Citrix is working to improve the licensing experience in My Account on citrix.com. You can choose Manage Licenses to easily find, allocate, download, modify, return, hide, and unhide licenses. The legacy All Licensing Tools experience is still available for a limited time.

Citrix Licensing version 11.16.3 is Windows only and doesn’t support License Server VPX.

Every Citrix product environment must have at least one shared or dedicated License Server. License Servers are computers that are partly or completely dedicated to storing and managing licenses. Citrix products request licenses from a License Server if users attempt to connect.

**Servers running Citrix products contact the License Server to obtain licenses.**

If users connect to a Citrix product, it draws licenses from the License Server. The Citrix product requests to check out a license from the License Server on behalf of the user or client device. When the license is successfully checked out, the user can run the product.
Depending on the size and configuration of your product deployment, you might deploy licensing on a server shared with other applications, a dedicated License Server, or multiple License Servers.

License files must be on the License Server that is associated with the product you are licensing. The product must be configured to communicate with that specific License Server. The Citrix Licensing Manager and License Administration Console let you manage and monitor your Citrix licenses by providing a user interface to the License Server. You can view licenses and alerts, import license files, create historical usage reports, and manage License Server settings.

What’s new

November 15, 2019
**Licensing 11.16.3**

**Note:**
Citrix is working to improve the licensing experience in My Account on citrix.com. You can choose Manage Licenses to easily find, allocate, download, modify, return, hide, and unhide licenses. The legacy All Licensing Tools experience is still available for a limited time. Citrix Licensing version 11.16 is Windows only and doesn’t support License Server VPX.

What’s new in the License Server 11.16.3

**Apache upgrade:**
The Citrix Licensing Manager and the Citrix License Administration Console have been upgraded to Apache version 2.4.39.

**Fixed issues:**
This release of the License Server fixes several previously reported issues. For more information, see Fixed issues.

Fixed issues

October 7, 2019

- The descriptions for the lmadmin event log messages might not be included in the Citrix Virtual Apps and Desktops and XenApp and XenDesktop installation logs and the licensing log. [LIC-445]

- After starting the Citrix Licensing Manager and entering credentials for authentication, the authentication might fail. [LIC-551]

- If you click the Web Services for Licensing Port edit box in the Citrix Licensing Manager > Settings > Server Configuration screen but don’t change the port number, the Save button might become active. Also, this message might appear - This port is already in use. Type another port number between 1 and 65535. [LIC-560]

- If you change the status of the Supplemental Grace Period in the Citrix Licensing Manager > Settings > Server Configuration screen, a message appears indicating that the change did not occur. [LIC-568]

- udadmin -list or udadmin -export might not list all the user/device details. [LIC-739]
Known issues

October 18, 2019

This article contains:

- General known issues
- License file issues

General known issues

- The License Server version 11.6.3.0 build 28000 does not support concurrent licensing when using XenApp 6.5 or earlier.

- When you access the Citrix Licensing Manager from the Start menu for the first time after installation, an error message might appear on Firefox and Chrome browsers. [LIC-195]

- The Citrix Licensing Manager and the License Administration Console do not differentiate between users and groups. For example, you can choose to add a user but add a group instead. [LIC-438]

- The Windows 2016 Start menu, might not list the Citrix Licensing Manager and the License Administration Console. Workaround: Use these URLs to access the consoles:

  https://licenseservername:8083 for the Citrix Licensing Manager

  https://licenseservername:8082 for the License Administration Console [LIC-506]

- When registering your License Server with Citrix Cloud, the Citrix Licensing Manager UI might stick and display a spinning wheel. To avoid this issue, before registering your License Server with Citrix Cloud, ensure that you have the Digicert Global Root CA certificates installed in the system. These certificates are updated in the Windows update. If they're not installed, manually download and install the certificates before starting the Citrix Cloud registration. [LIC-1510]

License file issues

- The License Server ignores license files that have multiple lines referencing HOSTNAME=. Licenses in these files cannot be checked out. This issue is caused when you download licenses associated to different License Server host names in to the same license file. The License Administration Console displays the following error message: “…Error List Returned…Unknown Host.”

  To resolve this issue, download again separate license files for each Citrix product tied to different License Server names.
Third party notices

September 18, 2019

Citrix Licensing 11.16.3 might include third party software licensed under the terms defined in the following documents:

- Non-Commercial Software Disclosures For FlexNet Publisher 2019 (11.16.4) (PDF download)
- FlexNet Publisher Documentation Supplement Open Source Licenses applicable to FlexNet Publisher 11.16.1 (PDF download)

System requirements for Citrix Licensing

September 18, 2019

Requirements for Licensing

Citrix Licensing is compatible with the same hardware required to support the compatible operating systems. No additional hardware is required.

Notes:

The License Server does not support multi-homing (two network cards plugged into distinct networks).

The License Administration Console manages the License Server on the computer on which it is installed. It doesn’t manage remote or third party License Servers. The Citrix Licensing Manager installs licenses only on the License Server where it is installed. We recommend installing the License Server on server operating systems only. Any server or client operating system using a web browser can access the consoles. License Servers don’t communicate with each other.

Operating system:

You can install the License Server on servers running the following Microsoft operating systems. We recommend that you install the latest Microsoft Service Pack and updates.

- Windows Server 2019 Family
- Windows Server 2016 Family
- Windows Server 2012 R2 Family

Server Core installations are not supported.

Disk space requirement:
• 161 MB for the licensing components
• 2 GB for user/device licensing
• More disk space might be required based on the amount of historical data that is configured in
  the Citrix Licensing Manager.

**Microsoft .NET Framework minimum requirements:**

• Microsoft .NET Framework 4.7.1

**Cluster platforms:**

• Windows Server 2019 Family
• Windows Server 2016 Family
• Windows Server 2012 R2 Family

**Browsers:**

We tested the following browsers. Other browsers might work, but all functionality might not be avail-
able.

• Microsoft Edge
• Mozilla Firefox
• Chrome
• Safari

**Where to find license management documentation**

October 29, 2019

In some cases, there might be more than one way to manage your licenses. This article links to our
various license management articles.

**Citrix Licensing Manager (The recommended License Server management method.)**

• Install licenses
• Dashboard with information about your licenses
• Historical usage reports
• Check for and download Customer Success Services renewal licenses
• Settings for the account, server configuration, and usage and statistics

**License Administration Console**

• Install licenses
• Change port numbers
• Change the default and display language
• Set thread use
• Configure the vendor daemon
• Monitor licenses and alerts
• Security
• System information, logs, and alerts

License Server administration without a console

• Customer Success Services
• Delete license files
• Disable the domain name truncation

Manage Licenses in My Account on citrix.com

• Allocate licenses
• Modify licenses
• Download licenses
• Hide and unhide licenses
• Return licenses
• Upgrade license edition
• Manage multiple licenses
• Install licenses
• Search for licenses
• Filter licenses
• Create product license report

Licensing commands

• lmadmin
• lmdiag
• lmdown
• lmhostid
• lmreread
• lmstat
• lmutil
• lmver
• udadmin
Licensing FAQ

October 7, 2019

These questions are asked frequently about your licensing environment.

**What is a license file and what do I do with it?**

The license file is a text file that contains the following:

- Product licensing information
- License Server name (or other binding identifier)
- Customer Success Services membership renewal date
- License expiration date (if applicable)
- Other system information

When you purchase a Citrix product, you are entitled to a license file. The License Server uses this file to determine whether to grant a license to a Citrix product.

**What does allocating licenses mean?**

When you allocate licenses, you apportion purchased licenses by product and License Server so you can split them among multiple environments or use cases. For example, your organization might own 1,000 licenses for the same product. You might want to use 800 in 1 location and 200 in another location. You can allocate 800 licenses to a License Server in the first location today, and allocate the remaining 200 later to a different License Server.

**What’s the difference between a host ID type and a host ID?**

The Host ID type is the required binding type you supply to allocate licenses. The Host ID is the License Server host name, MAC address, or other binding ID required to allocate licenses.

**Why can’t I partially allocate some licenses?**

Some licenses do not allow partial allocation.

**Why would I return a license?**

An example would be if you’re decommissioning a License Server, but you’re not ready to deploy existing licenses elsewhere.
What happens to returned licenses?

Returned licenses are put back in the licensing pool. You can then allocate these licenses in any quantity at any time. After you return a license, remove the old license file from the License Server.

What happens when I archive a license?

Archiving doesn’t remove licenses from an account. Archiving removes them from view. To view archived licenses, click the Archive tab under View Licenses.

How can I get a copy of my license file?

You can obtain a copy of your license file from your License Server. Alternatively, all purchased licenses and allocated license files are available from the secure My Account > Manage Licenses portal at www.citrix.com.

Can I rename the License Server?

License files run only on the License Server for which they were made. License files contain the host name or binding identifier of the License Server you specify when you allocate the licenses. You cannot use the license file that you generated for a particular License Server or a MAC address (for an appliance), on a different License Server or appliance.

Create license files that reference the new server name or MAC address by reallocating and generating the new file on citrix.com.

If I upgrade my License Server does it affect my license files?

No. The License Server and all product licenses are fully backward compatible and do not introduce any issues into your environment.

Can a single License Server supply licenses to users connecting from different servers using different product editions?

Yes. One License Server can contain licenses for multiple editions of a Citrix product. The type of license checked out corresponds to the edition that is configured on the product server. A product server is configured to consume a specific edition of a license and checks out that license edition.

For example:
ProductServerA is configured to check out Advanced licenses.

ProductServerB is configured to check out Premium licenses.

LicenseServer1 contains both Advanced and Premium licenses.

- Users who connect to LicenseServer1 from ProductServerA check out Advanced licenses only. After the number of Advanced licenses on LicenseServer1 is exceeded, new requests from ProductServerA users are denied until existing Advanced connection licenses are released.
- Users who connect to LicenseServer1 from ProductServerB check out Premium licenses only. If the number of Premium licenses on LicenseServer1 is exceeded, new requests from ProductServerB users are denied until Premium connection licenses are released.

Note

License checkout times might increase if many product servers that have many users are contacting the same License Server simultaneously. One License Server can accept only 10,000 inbound TCP/IP requests at one time. If you are planning to have more than 10,000 Citrix product servers connecting at the same time, we recommend that you use several License Servers. These product servers can include Citrix Virtual Apps and Desktops, Delivery Controllers, and Appliances.

Examples of possible deployments:

Scenario 1: Two sites

- SiteA contains product servers configured for the Advanced edition.
- SiteB contains product servers configured for the Premium edition.
- One License Server (shared).
- User1, User2, User3, User4…User5000 connect only to SiteA.
- User5001, User5002, User5003…User10000 connect only to SiteB.

Scenario 2: One site

- The site has two sets of published applications.
- The site is configured as Citrix Virtual Apps and Desktops Premium concurrent and Delivery Groups 2 as Citrix Virtual Apps and Desktops user/device
- One License Server (shared).
- User1, User2, User3, User4…User5000 connect only to the concurrent licenses.
- User5001, User5002, User5003…User10000 connect only to Delivery Group 2 user/device licenses.

Disaster recovery and maintenance

How do I license my disaster recovery site?

You can use the same licenses for your disaster recovery that you use for your production environment.
• Configure and manage your disaster recovery environment independently of your production environment.
• Don’t use both the production and backup License Servers to service license checkouts at the same time.
• Make only one License Server accessible at any one time
• The License Server in your disaster recovery environment must have an identical host name to the License Server in your production environment.

What happens if my License Server is offline for maintenance activity?

The standard 30-day grace period allows your systems to continue to function without degradation of performance or denial of service to support License Server maintenance requirements.

What can I do if my License Server is unrecoverable?

When you have a backup copy of your license files available, you have 30 days to do the following:

1. Rename an existing server in your environment to have the identical host name as your original License Server.
2. Install the License Server component and your backup license files to relicense your environment.

What can I do if my License Server is unrecoverable and I do not have a backup copy of my license files immediately available?

When you don’t have a backup copy of your license files immediately available, you have 30 days to access your My Account > Manage Licenses portal at www.citrix.com. To relicense your environment, do the following:

1. Download your license files.
2. Rename an existing server in your environment to have the same host name as your original License Server.
3. Install the License Server component and the license files you downloaded.

What can I do if my License Server is unrecoverable and I cannot rename an existing server in my environment?

When you can’t rename an existing server in your environment, you have 30 days to relicense your environment. Do the following:

1. Identify another server in your environment.
2. Install the License Server component.
4. Return and reallocate your license files using the host name of the new server you selected.
5. Download and install these license files.

Does any failure of the License Server degrade performance or deny service to users?

No. The 30-day grace period prevents you from experiencing degradation in performance and denial of service to users.

Citrix licensing technical overview

September 18, 2019

Before you can use your Citrix product, you must install Citrix licensing. Citrix licensing is a system of components that function together. This system includes:

License server. A system that allows licenses to be shared across the network.

License files. The files required to license your product. These files are stored on the License Server.

Citrix Licensing Manager. The recommended License Server management method that enables the following:

- Short code process to register with Citrix Cloud.
- Easy process to remove Citrix Cloud registration.
- Dashboard to monitor license activity.
- Force data uploads to immediately confirm the license usage.
- Exporting license use data for reporting.
- Configure the user and group access to manage the License Server.
- Installation of licenses by using the license access code or a license file (.lic).
- Enable and disable the supplemental grace period.
- Change these ports:
  - License Server (default 27000)
  - Vendor Daemon (default 7279)
  - Web Services for Licensing (default 8083)
- Display details of licenses after they are installed using a license access code or downloaded file.
- Configuration of Customer Experience Improvement Program (CEIP) and Call Home.
- Retry failed usage statistic uploads to Citrix.
- Automatically or manually checks for Customer Success Services renewal licenses and notifies you or installs the licenses if found.

© 1999-2019 Citrix Systems, Inc. All rights reserved.
• Configure the historical use data retention period. Default data retention period is 180 days.
• Notifies you of the License Server state - Missing startup license, time issues, uploader failures.

**License Administration Console.** Another interface you can use to manage your license files and your License Server.

**Web Services for Licensing.** Enables Studio, Director, and the Licensing Administration PowerShell Snap-in to:
  • Communicate with the License Server and manage users.
  • Allocate and install licenses.
  • Display License Server health, license usage, and other alert messages.

**Citrix License Management Service.** Enables management of your license environment through a license management console within Citrix Insight Services. This service assists with license management and support:
  • Allocating new licenses if you are about to exceed your license capacity
  • Rescinding old licenses after an upgrade
  • Managing duplicate licenses in a Disaster Recovery (DR) environment

**Product-side settings** in your Citrix products that are associated with the License Server.

For more information, see **Licensing elements and Services.**

**Licensing operations overview**

Typically, the first time a user connects to a Citrix product, the product requests a license from the License Server. When the License Server grants a license request, the Citrix product reserves a license for its use. Reserving licenses for this purpose is known as checking out licenses. When the user logs off from the product server, the product returns the license to the License Server. This process is known as checking in licenses. Some Citrix products check out the license when a user connects to the product. The license remains checked out for a predetermined amount of time.

Each time a Citrix product starts, it opens a connection to the License Server by checking out the startup license. The startup license is a Citrix system file that enables Citrix products to maintain a continuous connection to the License Server. The following figure shows that each product forms its own constant connection to the License Server.

For example, when a server running Citrix Virtual Desktops requests a license, the product retrieves the License Server name and port number information from the data store. The product then establishes a connection to acquire the licenses.

**Note**

When configuring the product-side setting for the License Server name, do not use localhost.
Though you can use the host name, IP address, or FQDN instead, Citrix recommends that you use the FQDN.

There are three stages of the license checkout process.

A Citrix product goes through a three-step process to check out licenses:
1. At startup, a computer running a Citrix product checks out a startup license.
2. A client device connects to the product server.
3. The product requests a license from the License Server.

Citrix products, such as Citrix Virtual Desktops, store a replica of the licensing information from the License Server, including the number and type of licenses. If a Citrix product server loses its connection to the License Server, or the License Server does not respond in a timely manner, the product enters a grace period. During the grace period, the product uses its local record of the licenses to continue licensing the product. Citrix products update this record every hour.

**Scalability**

This section provides guidance to ensure successful License Server usage by examining the impact of license usage scalability in a Citrix environment. We performed this scalability testing:

Virtual Machine Hardware/Configuration:
Intel Xeon E5-2650 v3 @ 2.30 GHz
Licensing 11.16.3

4 Virtual CPUs
8 GB RAM
Windows Server 2016

6.5 and earlier Concurrent:
• 3000 connected Citrix Virtual Apps servers
• 53,000 concurrent licenses
• 50–60 connections per second

Efforts to scale more than 53,000 licenses result in servers going into a grace period. Also, there are issues with WMI, lmstat, and the License Administration Console. We recommend that you maintain 50,000 or fewer concurrent connections per License Server.

7.x Concurrent:
• 16 Delivery Controllers
• 70,000 concurrent licenses
• 50–60 checkouts per second

7.x User/Device:
• 16 Delivery Controllers
• 150,000 user/device licenses
• 50/60 checkouts per second

CITRIX.exe is a single threaded process. While it’s serving Concurrent connections, the maximum connection limit is based on the single core processor speed. During peak activity, CITRIX.exe uses 100% of a single core and eventually starts timing out. This usage might cause Citrix products to go into a grace period or errors in the License Administration Console or other License Server utilities. After the License Server has processed backlog connections, it returns to normal. Monitor the CITRIX.exe processor usage to determine if a faster processor is required. We recommend if you experience issues in high scalability environments, you deploy more License Servers.

User/Device technology is multi-threaded and scales better than Concurrent. During license optimizations, you might see that periods were licensing activity takes 100% of a single core. This usage is normal and doesn’t impact the CITRIX.exe processor usage or functionality. We recommend that you monitor License Server resource usage and add more License Servers to maintain a properly functioning environment.

We recommend that you specify thread use to improve performance. For more information, see improve performance by specifying thread use.

Note
Running WMI, lmstat, lmutil, or other inventory actions can negatively impact the License Server performance. We recommend that you minimize these activities. If you require usage
data, export the data from the Citrix Licensing Manager. For more information, see Historical usage.

**Grace period**

If product servers lose communication with the License Server, the users and the products are protected by a grace period. The grace period allows the product servers to continue operations as if they were still communicating with the License Server. After the Citrix product checks out a startup license, the product and the License Server exchange “heartbeat” messages every five minutes. The heartbeat indicates to each that they are still up and running. If the product and the License Server don’t send or receive heartbeats, the product lapses into the licensing grace period and licenses itself through the cached information.

Citrix sets the grace period. It is typically 30 days but can vary depending upon the product. The Windows Event Log, and other in-product messages, indicate if the product has entered the grace period, the number of hours remaining in the grace period. If the grace period runs out, the product stops accepting connections. After communication is re-established between the product and the License Server, the grace period is reset.

The grace period takes place only if the product has successfully communicated with the License Server at least once.

**Grace period example - two sites, both using the same License Server:**

The connection between Site 1 and the License Server goes down causing Site 1 to go into the grace period, continuing operation and making connections. For concurrent licenses, they can connect up to the maximum concurrent licenses installed. For user/device licenses, they have unlimited connections. When Site 1 reestablishes communication with the License Server, connections are reconciled and no new connections are allowed until they are within normal license limits. Site2 is unaffected and operates as normal.

If the License Server goes down, both sites go into the grace period. Each site allows up to the maximum number of licenses installed. As above, the user/device licenses have no limit.

**Supplemental grace period**

For the supplemental grace period to be available, you must use a minimum of XenApp 7.6 or XenDesktop 7.6.

If all licenses are in use, including the license overdraft, supplemental grace period enables unlimited connections to a product, allowing you to understand and address the issue. This period lasts until 15 days elapses or you install more retail licenses, whichever comes first. We recommend that after the
supplemental grace period starts, you allow it to run out rather than adding licenses immediately to clear the warning condition.

After the period expires, normal connection limits are enforced. Users are not disconnected. As they disconnect, no new connections can occur until the license levels return to normal.

After the supplemental grace period completes, it isn’t automatically re-enabled. To re-enable the supplemental grace period, install another retail license, and then normal license limits are enforced. When you re-enable the supplemental grace period by installing the new retail license, a new 15-day supplemental grace period starts the next time you exceed maximum installed licenses.

**Note:**

If you install licenses while the supplemental grace period is in force, the License Server exits the supplemental grace period. Reenabling the supplemental grace period before determining the reason for the supplemental grace period might cause you to reenter the period after installing new licenses.

Supplemental grace periods are granted per product version and edition and only for retail licenses. The supplemental grace period is enabled by default when you first install licenses. To configure the supplemental grace period, use the Citrix Licensing Manager.

### Supplemental grace period example

If you have a maximum count of 1000 licenses installed, and you make another connection (maximum licenses + 1), the supplemental grace period starts. You then have a temporary, 15-day period giving you extra capacity to deal with unforeseen capacity issues.

**Important:**

The supplemental grace period and license overdraft are two different features. The supplemental grace period is a feature of the product and the License Server. License overdraft is a feature of the license. For information about the license overdraft, see [License overdraft](#).
The License Server comprises several licensing elements:

- Citrix vendor daemon
- Options configuration file
- Citrix Licensing Customer Experience Improvement Program (CEIP) and Call Home
- License request process

This diagram shows the Citrix product using TCP/IP to connect to the License Server.

**Citrix vendor daemon**

The Citrix vendor daemon (CITRIX), a process that runs on the License Server, grants licenses. The Citrix vendor daemon tracks the number of licenses that are checked out and which product has them.
Citrix products communicate with the Citrix vendor daemon using TCP/IP. By default, the Citrix vendor daemon uses TCP/IP port 7279.

**Options file**

The options file (Citrix.opt) is a License Server configuration file. The Citrix vendor daemon reads this file every time it restarts or receives a command to reread the file. This configuration file defines licensing behavior—the number of licenses a product server can use, the location of the System Logs, logging levels, and other user-defined customizations. The Customer Experience Improvement Program (CEIP) and Call Home configurations are stored in this file.

**Important**

Flexera offers ways to edit the options file to control, reserve, or limit licensing usage. The Flexera methods are not compatible with Citrix licenses. Therefore, we do not support those editing options.

**Citrix licensing Customer Experience Improvement Program (CEIP) and Call Home**

The Citrix Licensing CEIP and Call Home usage and analytics programs are voluntary data collection programs designed to improve your product experience. After installing the License Server, you can participate in the programs anonymously or choose to be identified. Internet access is required. For information about configuring a proxy server, see *Configure a proxy server for use with Citrix Licensing Manager, Customer Experience Improvement Program (CEIP), and Call Home* in the Get started article.

CEIP is enabled by default during License Server installation. You can change your participation in the program at any time by using the Citrix Licensing Manager.

**Important**

The Citrix Service Provider program requires CEIP and Call Home. If you have Citrix Service Provider licenses installed, you can change the settings, but you cannot disable CEIP or Call Home. When the License Server detects Citrix Service Provider licenses, it enforces daily uploads.

When installing licensing on the command line, use CEIPOPTIN to specify whether, or how, to opt in to CEIP or Call Home Optional parameter. The default is CEIP.

- Diagnostic - Call Home
- Anonymous - CEIP
- None

For more command-line installation information, see the “Use the command line to install licensing” section under *Install licensing components for Windows.*
Citrix Licensing Customer Experience Improvement Program (CEIP)

CEIP is voluntary. When you opt in, the CEIP services running in Citrix products gather anonymous configuration and usage data from your deployment. The services automatically send the data to Citrix once a day, based on the service start time. CEIP collects these classes of data:

- Configuration data
- Performance and reliability data

How your privacy is protected:

- Citrix does not collect any personally identifiable data.
- Random identifier is created at install time, which tracks data transfers over time.
- Citrix does not record information such as IP addresses, server names, or domain names.
- All data is sent using HTTPS directly to Citrix servers - no third-party data hosting services.
- All data is secured on Citrix servers and is accessible only by authorized individuals.

Citrix Call Home

Call Home is voluntary. When you opt in, Call Home performs a periodic collection of system and product configuration, performance, errors, and more. The data identifies you as a customer. This information is transmitted to Citrix Insight Services once a day, based on the service start time. Citrix support and product teams use the information to resolve issues proactively.

License request process

When a product requests a license from the License Server, the Citrix vendor daemon determines whether a license is available for the request.

The license request process has two phases: the product startup phase and the user connection phase.

Product Start-Up Phase:

- When a Citrix product starts, it retrieves the License Server location from its data store.
- The product connects to the Citrix vendor daemon.
- The product checks out a startup license.

User connection phase:

- A user connects to a computer running the Citrix product.
- The product requests a license from the License Server.
- The Citrix vendor daemon checks to see if any licenses are available and grants or denies the product's request.
The license module in the product grants or denies the use of the product based on the response from the Citrix vendor daemon.

License types

October 7, 2019

Your product uses one of the following types of licenses (some products allow you to select more than one type). To avoid running out of licenses, ensure that you are aware of the types of licenses that your company purchased and how they consume them. We also offer license overdraft as a feature of the license files. See the license overdraft description at the end of this article.

The license types are:

User/device licenses

With a minimum of XenDesktop 5 Service Pack 1, XenApp 6.5, and Citrix Virtual Apps and Desktops 7 1808: The License Server can assign licenses to a user or a device and monitor license consumption. When assigned to a user, the license allows access from an unlimited number of devices. When assigned to a device, the license allows access from the device by an unlimited number of users.

A licensed device requires a unique device ID and is authorized for use by any individuals to access instances of Citrix Virtual Desktops. Use this type of license for shared devices, such as a classroom or hospital.

A licensed user requires a unique user ID, such as an Active Directory entry. When assigned to a user, the license allows the user to connect to their desktops and applications using multiple devices. For example, desktop computer, laptop, netbook, smartphone, or thin client. A licensed user can connect to multiple instances of Citrix Virtual Desktops concurrently.

When users or devices connect to an application or desktop, they consume a license for the 90-day license assignment period. The assignment period begins when a connection is made. The period is renewed to the full 90 days during the life of the connection. Expiration (allowing reassignment) is 90 days after the last connection ends (logs off or disconnects). If you have to end a license assignment manually before the 90-day period elapses, use the uadmin command-line tool. For example, an employee consuming a user license leaves the company.

Optimization

The License Server uses the optimization process to determine how to minimize consumption based on licenses in use and connections to the License Server. The License Server optimizes every five
seconds until there are 5000 unique connections. At 5000 unique connections, optimization occurs every five minutes. Optimization might delay status information until the next optimization impacting when license usage statistics are updated in various consoles.

Examples of unique connections - Optimization is not consumption and these examples show when optimization occurs.

Optimization occurs every five seconds for 1-4999 uses and every five minutes for 5000 or more uses.

700 users * 1 device each = 700 (optimize every 5 seconds)

5000 users * 1 device each = 5000 (optimize every five minutes)

5000 devices * 1 user each = 5000 (optimize every five minutes)

2500 users * 2 devices each = 5000 (optimize every five minutes)

Note:

If you have a large deployment, optimization can be CPU intensive depending on the number of unique connections. We recommend using machines with multiple cores.

** Concurrent licenses **

This type of license is not tied to a specific user. When a user starts a product, the product requests the license and it’s checked out to the specific computer or device that the person is using. When the user logs off or disconnects from the session, the license is checked back in and is available for another user. Using this logic, keep the following scenarios in mind:

- Multiple sessions at different computers use multiple licenses. Each time a user starts a Citrix session from a different computer or device, a license is checked out until the user closes the session at that computer or device. At that point, the license is checked back in. For example, a user starts a session from one computer and then starts another from another computer before closing the first session. Two licenses are checked out.

- License Servers do not communicate with each other. If you run multiple License Servers, you might consume more than one license (for example, with load balancing). If you are using load balancing, we recommend that the product servers point to the same License Server.

- Different editions consume different licenses. If a user connects to an application published on a computer running the Advanced edition, and then uses the same client to connect to an application published on a computer running the Premium edition, two licenses are consumed.

- A user makes multiple connections from a single device to different product servers configured as the same edition and pointing to the same License Server. Only one license is consumed.
• For license sharing, pass-through connections on Citrix Virtual Apps and Desktops pass the end-point client device ID to the product server. If you connect to a single product, edition, and license model with a shared License Server, all connections share a single license.

• A user connects from a single device to two product servers that are the same edition but different versions. One or two licenses might be consumed based on the order in which the user makes the connections. For example, the two servers are Citrix Virtual Apps and Desktops 7 1811 and Citrix Virtual Apps and Desktops 7 1903 (though this example applies to nearly all Citrix products and versions):
  – The user connects to Citrix Virtual Apps and Desktops 7 1811 first - Two licenses might be consumed - An older license first and then a newer license.
  – The user connects to Citrix Virtual Apps and Desktops 7 1903 first - Only one license is consumed.

• RDP connections consume a license (RDP connections to a console do not consume a license).

• If the number of purchased and available standalone concurrent licenses is exceeded, all users over the limit are denied access unless the supplemental grace period is possible. For more information, see Supplemental grace period.

**Per user licenses (only user licenses - not the same as user/device licenses)**

A licensed user requires a unique user ID, such as an Active Directory entry. When assigned to a user, the license allows the user to connect to their desktops and applications using multiple devices. For example, desktop computer, laptop, netbook, smartphone, or thin client. A licensed user can connect to multiple instances of Citrix Virtual Desktops concurrently. A licensed user can connect to multiple instances of a product concurrently. When users connect to an application or desktop, they consume a license for the 90-day license assignment period. The assignment period begins when a connection is made. The period is renewed to the full 90 days during the life of the connection. Expiration (allowing reassignment) is 90 days after the last connection ends (logs off or disconnects). If you have to end a license assignment manually before the 90-day period elapses, use the `udadmin` command-line tool. For example, an employee consuming a user license leaves the company.

**Per device licenses (only device licenses - not the same as user/device licenses)**

A licensed device requires a unique device ID and is authorized for use by any individuals to access instances of a product. Use this type of license for shared devices, such as classroom or hospital. It allows an unlimited number of users per device. When devices connect to an application or desktop, they consume a license for the 90-day license assignment period. The assignment period begins when a connection is made. The period is renewed to the full 90 days during the life of the connection. Expiration (allowing reassignment) is 90 days after the last connection ends (logs off or disconnects).
If you have to end a license assignment manually before the 90-day period elapses, use the `udadmin` command-line tool. For example, an employee consuming a user license leaves the company.

### Per socket licenses

Licenses are consumed per CPU socket used by a CPU and cores are not counted. For example, if a computer having two CPU sockets has only one CPU, only one license is used. In another example, if that same computer with two sockets has two CPUs, each with a quad core, only two licenses are used.

### Named user licenses

When a product requests a license, it is checked out to the user until a preconfigured period expires. This type of check-out is not tied to a computer or device. After the license is checked out, the user can run multiple sessions on different computers without checking out more licenses.

### License overdraft

License overdraft is included in all user/device, per user, and per device licenses. When you purchase user/device licenses, you receive a 10% overdraft. The overdraft becomes available after you allocate all your purchased and evaluation licenses. Overdraft usage is reported in the Citrix Licensing Manager, Studio, and the License Administration Console. The overdraft feature, and the supplemental grace period, are offered as a convenience, not as a license entitlement. Purchase any overdraft or supplemental grace period licenses within 30 days of first use. Citrix reserves the right to remove any overdraft or supplemental grace period feature in new product releases.

Example:

You purchase 1,000 user/device licenses and get 10% overdraft. You can use up to 10% more than the 1,000 licenses but must purchase any licenses used over 1,000 within 30 days of first use.

For more information about the supplemental grace period, see [Supplemental grace period](#).

### License files

October 7, 2019

When you install the License Server, a startup license and an options file are installed automatically. To license your Citrix products, you add one or more license files. For information about adding your product licenses, see [Install licenses](#).
You cannot change the location of license files on the License Server. License files must reside in their default location.

**Startup license file**

The startup license file (citrix_startup.lic) is a text file that Citrix products use to communicate to the License Server using a continuous open connection. Every five minutes the License Server and the product send a heartbeat message to each other to verify that they are mutually communicating. When the product and License Server are exchanging heartbeat messages, but there is an interruption in the exchange, the product goes into a grace period. A power failure is an example of an interruption. The startup license does not affect your license count.

**Citrix License Server Diagnostics License|Server**

The License Server uses Citrix License Server Diagnostics License|Server for internal diagnostics and alert message notifications displayed in Studio and Director. It is available by default with the startup license in the citrix_startup.lic file.

**Warning**

Do not edit the startup license file, or any other license files.

**License file**

The license file is a text file containing the following:

- Product licensing information
- License Server name (or other binding identifier)
- Customer Success Services membership renewal date (also known as the Customer Success Services expiration date)
- License expiration date (if applicable)
- Other system information

All this information is encrypted using a digital signature. When you purchase a Citrix product, go to the citrix.com website to download a license file. You can have more than one license file per License Server. The license file resides in these directories, where the License Server references it.

- C:\Program Files\Citrix\Licensing\MyFiles directory on a 32-bit server
- C:\Program Files(x86)\Citrix\Licensing\MyFiles directory on a 64-bit server

The License Server uses this file to determine whether to grant a license to a Citrix product.

A license overdraft is included in all user/device, per user, and per device licenses. For more information on the license overdraft, see License overdraft.
Move licenses to a different host

You cannot move the license files that you downloaded for the old License Server to a server that has a different host name or MAC address. Create license files that reference the new server name by reallocating them.

For more information, see Modify licenses.

License file format

Important

Changes can make license files unusable. If using Citrix Licensing for Windows 11.6.1 or later, editing license files is not necessary. You can manage licenses through the Citrix Licensing Manager, the License Administration Console, and the My Account site.

You can change the name of the license file, but it must have a .lic (lower case) extension.

Citrix license files use the following naming convention: license_FID_XDT-PLT-UD_25-mar-2013.lic

License files are composed of lines listing specific information, such as the server name (SERVER) or quantity of licenses (INCREMENT). These lines begin by using words denoting their purpose in uppercase letters, such as VENDOR, SERVER, INCREMENT, USE_SERVER.

The following sections provide in-depth information about the following elements of license file syntax: the SERVER line, VENDOR line, USE_SERVER line, and INCREMENT line. While the term feature is used in the options and license file syntax, in this document, the term product license is used whenever possible for clarity.

Example license file displaying numbers corresponding to the explanations following the example:

```
# This file is in UTF-8 format.
#
SERVER this_host HOSTNAME=license_server
VENDOR CITRIX
USE_SERVER
INCREMENT MPS_ENT_CCUI CITRIX: 2006 0429 01-mar-2006 1000
VENDOR_STRING=LT=Retail,GP=720,CL=ENT,ADV,STD,SA=0,ODP=0
DUP_GROUP=V_ISSUED=12-Mar-2004 NOTICE="Hello Test - Citrix"
SHA1=00003157712-66261 1672 START=11-mar-2004 SIGN=16886 1530
OAE2 EEC7 6644 921C 0E02 3649 A2CF 34ED A0BF 8D44 TS111
D759 1000 7635 553C D774 D8EC 1F3D AE03 DSFE D778 217B EN000
A14C 2B63 775B 4CF5
# #English#
#CITRIXTERM FEATURE 2.0 MPS_STD_CCUI EN Citrix Presentation Server Standard Concurrent User
#CITRIXTERM FEATURE 2.0 MPS_ADV_CCUI EN Citrix Presentation Server Advanced Concurrent User
#CITRIXTERM FEATURE 2.0 MPS_ENT_CCUI EN Citrix Presentation Server Enterprise Concurrent User
#
```

1 SERVER Line:

The SERVER Line. The SERVER line specifies the binding identifier (also known as the host name) of the License Server.
Licensing 11.16.3

Caution: Do not change the binding identifier on the SERVER line. Otherwise, the license file doesn’t work.

**Syntax:**

SERVER this\_\_host ether

Or

SERVER this\_\_host HOSTNAME=hostname

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ether</td>
<td>The MAC address of the appliance on which the License Server is running. Do not edit this text string.</td>
</tr>
<tr>
<td>hostname</td>
<td>The name of the computer on which the License Server is running. Do not edit this text string.</td>
</tr>
</tbody>
</table>

Example

```
1 SERVER this\_\_host HOSTNAME=license\_server1
```

**2 VENDOR Line:**

The VENDOR line specifies the Citrix vendor daemon name.

**Syntax:**

VENDOR CITRIX [vendor\_daemon\_path]

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VENDOR CITRIX</td>
<td>Name of the Citrix vendor daemon. Do not edit this name.</td>
</tr>
<tr>
<td>vendor_daemon_path</td>
<td>Path to the executable for the Citrix vendor daemon. Citrix recommends that you do not change this path.</td>
</tr>
</tbody>
</table>

**3 INCREMENT Lines:**

An INCREMENT line describes the license required to use a product. License files (*.lic) contain one or more INCREMENT lines. Each INCREMENT line makes up a user-specified allocation of product and
license (users, connections) counts.

Each increment line contains:

- A signature based on the data in that line
- The hostids specified in one or more SERVER lines
- Data selected by Citrix

INCREMENT lines use a backslash (\) to wrap long lines of text.

**Syntax:**

INCREMENT feature vendor css_expiry_date exp_date num_lic \ 
SIGN=sign [optional_attributes]

**Caution:**

Do not change the six fields after the INCREMENT line keyword. The fields are required and have a fixed order.

The following table explains these fields in the order they appear:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>feature</td>
<td>The product license. Do not edit this line.</td>
</tr>
<tr>
<td>vendor</td>
<td>Indicates that this license is for a Citrix vendor daemon. Do not edit this line.</td>
</tr>
<tr>
<td>CSS_expiry_date</td>
<td>Indicates the date until which you are entitled to product version upgrades. If you don’t have a Customer Success Services membership, or this license isn’t a Customer Success Services license, the date indicates when you ordered or redeemed the license. Do not edit this line. <strong>Note:</strong> If you renewed your Customer Success Services membership and received an upgrade license, the CSS_expiry_date is listed. <strong>Example:</strong> INCREMENT MPS_ENT_CCUCITRIX 2019.0311 permanent 1000 \</td>
</tr>
<tr>
<td>exp_date</td>
<td>Expiration date of license in the format dd-mmm-yyyy, that is, 07-may-2006. Do not edit this line. <strong>Note:</strong> If the exp_date field contains the text string permanent, the license never expires.</td>
</tr>
<tr>
<td>num_lic</td>
<td>Number of concurrent licenses for this product license. Do not edit this line.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SIGN=sign</td>
<td>SIGN= signature to authenticate this INCREMENT line. Do not edit this line.</td>
</tr>
</tbody>
</table>
| SUPERSEDE_SIGN=sign    | Strategically turns off specific licenses based on license feature and signature or INCREMENT line to be disabled. Customer Success Services or maintenance upgrade licenses include SUPERSEDE_SIGN. **Example:** SUPERSEDE_SIGN="{"CBR_100_SSERVER:0F76 2946 4790 6B67 08E0 65BC 302B E1B6 6ECE 41D6 8AB6 E9C6 FE44 4EB3 9A83 01E4 D405 3E95 74B8 9BC8 7791 BDD3 1385 33F8 9533 95FF A3E4 F461 35B4 251E"}"

INCREMENT lines also determine the grouping of licenses in the management console. These groups are known as license pools. The Citrix vendor daemon creates the license pools based on common attributes, such as product license or version. When a new pool is created, the console displays and tracks this pool independently from other license pools. When two or more attributes are different, the Citrix vendor daemon creates a license pool.

**Citrix Attributes in INCREMENT Lines:**

INCREMENT lines can also include more attributes from Citrix. These attributes provide information about the license, such as the date on which it was issued or that the license is an upgrade license.

**Caution:**

Do not change or remove these attributes.

**Example:**

```
INCREMENT MPS_ENT_CCU CITRIX 2003.0506 permanent 10 \
VENDOR_STRING=;LT=Retail;GP=720;CL=ENT,ADV,STD,AST;SA=1;DDP=0 \nISSUED=06-Jun-2007 NOTICE=\"Citrix\" \SN=12345:67890 \START=6-Jun-2007 \SIGN="18F8 1546 F605 E3BD 010E 7E4F A4B3 9DE3 B90E 7937 3337 0180 1FFB C6EB D491"
```

Important items are highlighted in the preceding example:

- The Product (license feature) appears in blue
- The Customer Success Services expiration date appears in red (Format: YYYY.MMDD)
- The License (user, connection) Count appears in GREEN

**Syntax:**
keyword=value

The following table describes the Citrix attributes. The uppercase letters of the attributes indicate that this attribute is not editable.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DUP_GROUP=V</td>
<td>This attribute allows license sharing for the same client device.</td>
</tr>
<tr>
<td>ISSUED=dd-mmm-yyyy</td>
<td>Date issued.</td>
</tr>
<tr>
<td>ISSUER=&quot;...&quot;</td>
<td>Issuer of the license.</td>
</tr>
<tr>
<td>NOTICE=&quot;...&quot;</td>
<td>Your company name.</td>
</tr>
<tr>
<td>SN=serial_num</td>
<td>A number that is used to identify INCREMENT lines.</td>
</tr>
<tr>
<td>START= dd-mmm-yyyy</td>
<td>The date from which you can use a license. The License Server cannot use licenses before their start date.</td>
</tr>
<tr>
<td>SUPERSEDE=&quot;MPS_ADV_CCU MPS_STD_CCU ...&quot;</td>
<td>This attribute appears in the upgrade license file when you move to a higher product edition. If this attribute appears, this line supersedes all licenses issued before the date specified in ISSUED= and they become ineffective.</td>
</tr>
<tr>
<td>VENDOR_STRING=&quot;...&quot;</td>
<td>Text string defined by Citrix.</td>
</tr>
</tbody>
</table>

**Example of a base license:**

```
1  INCREMENT CBR\_100\_SSERVER CITRIX 2016.1201 permanent 10 \ 
2  \ 
3  VENDOR\_STRING=;LT=Retail;GP=720;MAXBW=1;MLC=0;HA=0;CL=BRSE;SA=1;ODP =0 \ 
4  \ 
5  DUP\_GROUP=V ISSUED=18-dec-2005 NOTICE="Citrix" \ 
6  \ 
7  SN=100se200seB SIGN="1B19 C213 7517 CC62 756F 864C 9C93 06FC \ 
8  \ 
9  E1DE B5D5 D793"
```

**Example of a Customer Success Services renewal license containing SUPERSEDE_SIGN:**

```
1  INCREMENT CBR\_100\_SSERVER CITRIX 2017.1201 permanent 10 \ 
2  \ 
```
Licensing services

October 7, 2019

This article contains the following information:

- Web Services for Licensing
- Citrix License Management Service
- Citrix licensing Windows Management Instrumentation (WMI)

**Web Services for Licensing**

Studio, Director, and the Licensing Administration PowerShell Snap-in use Web Services for Licensing to do the following:

- Communicate with the License Server and manage users
- Allocate and install licenses
- Display License Server health, license usage, and other alert messages.

The Citrix Licensing Manager also uses it.

**Citrix License Management Service**

The License Management Service enables better capacity planning and license management. This service also helps you avoid prohibited practices:

- Duplication of licenses outside a Disaster Recovery (DR) environment
- Use of legacy licenses for new product versions
• Use of rescinded licenses

This service alerts the administrator in Citrix Insight Services about duplicate licenses in a Disaster Recovery (DR) environment. For more information about Citrix Insight Services, see Citrix Insight Services.

The License Management Service uses product telemetry, built into the License Server, to send data to Citrix Insight Services. The License Management Service is not a Windows service. The first upload occurs approximately five minutes after the License Server first starts, or restarts, and subsequent uploads occur once a day thereafter. The schedule resets if you reinstall the License Server. If an upload fails, another attempt is made in 24 hours until either the upload succeeds or you disable the License Management Service. Citrix might use uploads to help you understand and support your license environment. See Use the command line to disable or enable the License Management Service.

**Important**

Your installation of the License Server constitutes your acknowledgment of the License Management Service and your consent to use the License Management Service. You can disable the License Management Service anytime after installation.

The License Management Service collects this information:

- License serial numbers
- License Server GUID
- Licenses used count
- Feature name
- Product versions

**Citrix Licensing WMI**

The WMI service provides access to Citrix Licensing WMI classes. There’s a namespace (ROOT\CitrixLicensing) with a few classes (notably, `Citrix_GT_License_Pool`) that gives license usage and availability counts. Querying the License Server too often (more than every 15 minutes) might impact performance negatively.

**Customer Success Services**

August 16, 2019

When you purchase a new Citrix product, your purchase includes a one-year membership in Customer Success Services. This membership entitles you to, among other benefits, any product updates.
These updates include major and minor releases, released during your membership period. For example, if you purchased XenDesktop, Enterprise edition on July 22, 2015, you are entitled to any updates released for XenDesktop, Enterprise edition until July 22, 2016. After your initial one-year membership period expires, you can choose to renew your Customer Success Services membership. After paying Citrix for your renewal, you can use the Citrix Licensing Manager to install your renewal licenses. You can go to citrix.com and download a license file containing your renewal license.

**Important:**
A Customer Success Services membership and its associated license are distinct from your license to run the product. If you do not renew your Customer Success Services membership, your Citrix products do not stop working. However, you are not entitled to any software releases after it expires.

### Customer Success Services renewal licenses

Customer Success Services renewal license files contain licenses, known as renewal licenses, that extend your Customer Success Services membership for a one-year period. These licenses are required to run any new product releases, excluding hotfixes, that are released during your membership period.

If you do not add the Customer Success Services renewal licenses immediately, your Citrix products do not stop working. However, you cannot run any new software released during your renewed membership until you have the renewal license on your License Server.

You do not need to download more licenses when you install new versions of your products during this membership period. If Citrix releases a product version after your Customer Success Service membership ends, you must renew your Customer Success Services membership and obtain a renewal license before you can use the new product version.

**Example:**

Before you upgrade to any of the Citrix Virtual Apps and Desktops releases, ensure that your current Customer Success Services dates are valid and have not expired. Citrix Virtual Apps and Desktops releases use a Year Month format (YYMM). Citrix Virtual Apps and Desktops 1906 was released in 2019 in the sixth month. To upgrade any component in your Citrix Virtual Apps and Desktops deployment to version 1906, ensure that your current Customer Success Services dates are later than June 2019.

When you renew your Customer Success Services membership, you can use the renewal license features of the Citrix Licensing Manager. For more information see, Update licenses.

**Tip:**
When you download more license files, you can delete the expired Customer Success Services
You can find out what your Customer Success Services dates are by using:

- Citrix Licensing Manager (see [Citrix Licensing Manager](#))
- License Administration Console on the Dashboard (see [License Administration Console](#))
- Text editor to view the license file

### Check for and install Customer Success Services renewal licenses with the Citrix Licensing Manager

When enabled, the Citrix Licensing Manager contacts Citrix.com web services weekly to check for available Customer Success Services renewal licenses.

Based on how you configure it, the Citrix Licensing Manager automatically or manually checks for Customer Success Services renewal licenses. It notifies you or installs the licenses when found.

1. In the Citrix Licensing Manager, click the settings icon in the upper right of the UI.
2. Select how you want to be notified and if you want renewal licenses to be automatically installed.

If the automatic checks for Customer Success Services renewal licenses fail, check the firewall setting or configure a proxy. For this feature to work, the License Server must be able to access `https://citrixservices.citrix.com`.

For more information, see [Configure a proxy server manually](#).

**Tip:**

You can also configure the ports, the supplemental grace period, and the language on this page.

- **Automatically check for Customer Success Services renewal licenses and notify when available:** Citrix Licensing Manager displays a notification. Click a link to download and install available renewals. This same notification appears in Studio and Director if they are configured to manage the License Server.
- **Automatically check for and install Customer Success Services renewal licenses when available:** Citrix Licensing Manager checks weekly and automatically installs renewal licenses when available. A notification displays for a few days stating that renewals have been installed.
- **Manually check for Customer Success Services renewal licenses:** Select the **Update Licenses** tab and Check for Available Renewals. You can check the **Update Licenses** tab at any time to see a list of licenses installed in the last 30 days.
The License Server - get started, install, and configure

September 18, 2019

Important:
We recommend that you run the latest version of the License Server. We do not provide hotfixes for License Server components and don’t support older License Servers with newer products. The latest version of the License Server often contains resolutions to issues appearing in earlier versions. When you upgrade or install new Citrix products, upgrade the licensing components as well. New License Servers are backward compatible and support older products and license files. However, new products often require the newest License Server to check out licenses correctly. You can find the latest version from the Citrix Downloads site.

To see the new features in this release, go to What’s new.

This article contains the following information to help you get started with the License Server:

- Steps to license your product
- How to ensure that you have the latest License Server
- Security considerations
- Firewall considerations
- Install licensing components for Windows
- Use the command line to disable or enable the License Management Service
- Manually install a certificate used by the Citrix Licensing Manager and Web Services for Licensing
- Configure a proxy server for use with Citrix Licensing Manager, Customer Experience Improvement Program (CEIP), and Call Home

Licensing your product includes the following steps:

1. Ensure that you have the latest License Server version.
2. Verify system requirements.
3. Install licensing.
4. Obtain license files from My Account or if you have a license code, use Citrix Licensing Manager.
5. Install your Citrix product (or, if already installed, restart the Citrix products for the new licenses to be recognized)
6. Configure product-side licensing communication settings that were not set during the product installation, if applicable. This configuration includes setting the correct product-edition in the product. Details about these settings are covered in the product documentation.

Ensure that the product-side edition setting correctly matches the licenses you have purchased. For example, if you purchased Premium edition licenses, ensure that the edition setting in the
product indicates Premium-not Advanced.

Important:

The License Server does not require domain membership. You can install the License Server in a workgroup and still perform all licensing functions on behalf of Citrix products. To manage the License Administration Console or the Citrix Licensing Manager users having Active Directory users or groups, the users must be part of a domain. Otherwise, use local Windows users.

For an overview of the licensing components and process, see Technical overview and Licensing elements.

Ensure that you have the latest License Server

When upgrading or installing new Citrix products, always have the latest License Server. The new License Server is backward compatible and supports older products and license files. However, new products require the newest License Server to check out licenses correctly. You can install or upgrade the latest version from the product media.

To find your License Server version number:

If you are unsure if your License Server version is current, you can verify it by comparing your version to the number on the Downloads site.

On a License Server using the Citrix Licensing Manager:

1. Start the Citrix Licensing Manager.
2. See the release version in the bar at the top of the page.

On a License Server using the License Administration Console:

1. For windows: Start the License Administration Console from the programs menu: Citrix > License Administration Console.
   
   For remote systems: Open a web browser and go to https://License Server Name:secureWebPort.

2. Click Administration and select the System Information tab. See the release version in the information list.

Security considerations

We recommend that you upgrade the License Server to the latest version when you upgrade or install new Citrix products. New License Servers are backward compatible and support older products and license files. Each time we release a new License Server, it might contain better security features than in previous versions.
We also recommend the following security considerations when you configure your environment or use the Licensing Administration Console.

- Configure the License Server environment so that only authorized administrators on a trusted network can access the Licensing Administration Console port. You achieve this outcome by using an appropriately configured network or host-based firewall.
- When using the Licensing Administration Console, avoid visiting untrusted websites or clicking untrusted URLs.

**Firewall considerations**

Determine if you require a firewall between the License Server and any product servers before installing licensing. Firewall considerations can impact where you install the License Server.

If you have hardware firewalls in your environment, you must create the necessary rules manually.

If there is a firewall between your product and the License Server, configure port numbers. This configuration process entails:

- Determining which port numbers to change. You can change port numbers during the installation process or afterward.
- Opening up the firewall ports. Open any ports on the firewall that you changed so that traffic can flow. Current releases configure the built-in firewall automatically.
- Changing the product-side settings. Configure your Citrix product to use the same port numbers as in the License Administration Console. If you do not change the port number referenced in the product, the product cannot contact the License Server. You can change the product-side settings during and after installation of the product. See your product documentation for information about these settings.

**Installation consideration**

During installation, localized characters in the installation path can cause the installation to fail. Accept the default installation path or type only ASCII alphabetic letter characters for the installation directory.

**Install licensing components**

You can install licensing components on a separate, dedicated server or on a server they share with another application. Alternatively, you can use a web or application server. However, the locations mentioned later in this article are less resource intensive. If you are running fewer than 50 servers or 10,000 licenses, you can install the License Server on the same server as your product. To determine
if relocation of the License Server to another system is necessary, monitor CPU and memory load (lmadmin.exe and CITRIX.exe).

Important:

Use the **CitrixLicensing.exe** file for all future installations, except for Active Directory deployments. In that case, use the .msi.

Ensure that both .exe and .msi files are present for the installation.

**Install the License Server and console using the graphical interface**

1. Download the License Server from citrix.com and start the License Server installer, CitrixLicensing.exe, as an administrator or a member of the administrators group.

2. Follow the installer graphical interface to accept the destination folder.

   Licensing components are installed in `C:\Program Files\Citrix\Licensing` on a 32-bit computer and `C:\Program Files (x86)\Citrix\Licensing` on a 64-bit computer.

3. On the **Configure** page, accept or change the default port numbers used by licensing components. Choose whether to allow the installer to configure the Windows Firewall exception. If needed, you can change the port numbers after the installation. If you choose to finish the installation without configuring the License Server, restart the CitrixLicensing.exe installer. You can also use the License Server Configuration tool to configure the settings after the installation. Open the configuration tool from: `C:\Program Files\Citrix\Licensing\LS\resource\Licensing.Configuration.Tool.exe`.

   - License server port number is 27000
   - Vendor daemon port number is 7279
   - Management console web port is 8082
   - Web Services for Licensing port is 8083

4. The License Server adds the default administrator for the Citrix Licensing Manager and the License Administration Console based on how you are logged on. If you are in a domain, the License Server adds the installing user (domain\user) as a default License Administration Console administrator. If you are a local Windows user, the License Server adds the installing user (computer\user) as a default administrator account. The BUILTIN\administrator group, which allows any administrator to manage licensing, is added by default. You can remove BUILTIN\administrators to restrict licensing to specified users. Any user that has access to managing the Citrix Licensing Manager can also manage the License Administration Console.

5. Choose to start the Citrix Licensing Manager or the License Administration Console and whether to join the Citrix Customer Experience Improvement Program.
If you don’t choose the **Citrix Licensing Manager**, or a license from your product administration console, you can still get your licenses. Go to the [citrix.com](http://citrix.com) to obtain the license files for your Citrix products. This procedure is detailed in the “Obtain your license files” section later in this article.

**Use the Windows command line to install licensing**

**Important:**

The Citrix Service Provider program requires Customer Experience Improvement Program (CEIP) and Call Home. If you are a Citrix Service Provider, you cannot disable CEIP or Call Home.

When using the `CitrixLicensing.exe` command to install licensing, set properties by adding Property=value on the command line anywhere except between an option and its argument.

Ensure that you run the command line with administrator privileges. To start the command prompt with elevated privileges, choose **Start**, right-click **Command Prompt**, and choose **Run as administrator**.

The following sample command line installs licensing in silent mode. Add the properties you want to set.

Type the command in one line without returns. The following example is in multiple lines because of space limitations.

```plaintext
CitrixLicensing.exe /quiet /l install.log INSTALLDIR=installdirectory
WSLPORT=port\_number LSPORT=port\_number VDPORT=*port\_number MCPORT=
port\_number CEIPOPTIN=value
```

Where:

- `/quiet` specifies a silent (quiet) installation.
- `/l` specifies the log file location
- `INSTALLDIR` is the location where the License Server executable is stored. Optional parameter. The default is `c:\\program files\\citrix licensing or c:\\program files (x86)\\citrix\\licensing`.
- `WSLPORT` is the port number used for the Web Services for Licensing. Optional parameter. The default is 8083.
- `LSPORT` is the port number used for the License Server. Optional parameter. The default is 27000.
- `VDPORT` is the port number used for the vendor daemon. Optional parameter. The default is 7279.
- `MCPORT` is the port number used for the console. Optional parameter. The default is 8082.
• CEIPOPTIN specifies whether, or how, to opt in to Citrix Customer Experience Improvement Program (CEIP) or Call Home. Optional parameter. The default is ANON.
  
  – DIAG - Call Home
  – ANON - CEIP
  – NONE

You can change the CEIP and Call Home choice using the Citrix Licensing Manager.

Using the command line to install licensing for an Active Directory deployment:

When using the msiexec command to install licensing, set properties by adding Property="value" on the command line anywhere except between an option and its argument. Clustering is not supported in the .msi.

Note:

Ensure that you run the command line with administrator privileges. To start the command prompt with elevated privileges, choose Start, right-click Command Prompt, and choose Run as administrator.

The following sample command line installs licensing in silent mode and creates a log file to capture any information about this operation. Add the properties you want to set after the switches.

Type the command in one line without returns. The following example is in multiple lines because of space limitations.

**msiexec /I ctx\_licensing.msi /l*v install.log /qn INSTALLDIR=*installldirectory
* LICSERVERPORT=*port\_number* VENDORDAEMONPORT=*port\_number* MNGMTCONSOLEWEBPORT =*port\_number* WEBSERVICE LICENSINGPORT=*port\_number* CEIPOPTIN=*value
***

Where:

• /l*v is the location of the setup log. Optional parameter.
• /qn specifies a silent (quiet) installation.
• INSTALLDIR is the location where the License Server executable is stored. Optional parameter. The default is c:\program files\citrix licensing or c:\program files (x86) \citrix\licensing.
• LICSERVERPORT is the port number used for the License Server. Optional parameter. The default is 27000.
• VENDORDAEMONPORT is the port number used for the vendor daemon. Optional parameter. The default is 7279.
• MNGMTCONSOLEWEBPORT is the port number used for the console. Optional parameter. The default is 8082.
• WEBSERVICE_LICENSING_PORT is the port number used for the Citrix Licensing Manager. Optional parameter. The default is 8083.

• CEILOPTIN specifies whether, or how, to opt into Citrix Customer Experience Improvement Program (CEIP) or Call Home. Optional parameter. The default is ANON.
  – DIAG - Call Home
  – ANON - CEIP
  – NONE

You can change the CEIP and Call Home choice using the Citrix Licensing Manager.

Use the command line to disable or enable the License Management Service

The License Management Service operates automatically within the License Server and allows for license management and support. We recommend using the License Management Service for management of your license environment, but you can disable it anytime after installation. For more information, see “Citrix License Management Service” in Technical overview.

Syntax:

```
ctx_license_management_service.exe (-enable | -disable | -query)
```

Where:

- **-enable** enables license management. The first upload to Citrix occurs seven days after you install the License Server.
- **-disable** disables license management. We recommend that you use the License Management Service to manage your licensing environment.
- **-query** displays the current configuration.

Obtain license files using the License Administration Console

1. From a web browser, go to https://ls:8082.
2. Click Administration and Vendor Daemon Configuration.
3. Click Import License.
4. Click the citrix.com link.
5. On the My Account page, type your user ID and password.
6. Select Manage Licenses.
7. Select the licenses you want to allocate. The landing page displays only new licenses within 30 days and expiring term licenses. You can use the Filter by menu to search for specific types of licenses or select Quick find: All active to see all licenses.

8. From the Select an action menu, choose Allocate licenses. Follow the process to allocate and download your license file, and save the file to a temporary directory.

9. In the License Administration Console on the Import License File page, browse to the license file.

10. If you copied the file directly to the MyFiles directory, or if a file having the same name exists on the License Server, select Overwrite License File on License Server.

11. Click Import License.

12. Click Vendor Daemon Configuration and click Administer in the Citrix vendor daemon line.

13. Click Reread License Files to allow the License Server to recognize the new file.

Users can begin using these licenses when the License Server reads the licenses.

**Manually install a certificate used by the Citrix Licensing Manager and Web Services for Licensing**

*Note*

Use this procedure if you are a Director or Studio administrator who doesn’t want to use the self-signed certificate that is generated during installation.

To install a certificate, there are three steps:

1. Obtain a .pfx file, which contains the certificate and private key. You can use one of two methods to obtain the .pfx file.
2. Extract the certificate and private key from the .pfx file.
3. Install the certificate and private key on to the License Server.

**Step 1, method 1 - obtain the .pfx file using a domain certificate**

Log on to a server in the domain, open the MMC, and follow these steps:

1. Create a directory c:\ls_cert to hold the exported .pfx file.
3. In the left pane under Certificates, right-click Personal and choose All Tasks > Request New Certificate, and then Next.
4. In the Certificate Enrollment Policy wizard, choose Active Directory Enrollment Policy, and then Next. Select the check box next to Computer, and select Details to the right.
5. Select **Properties** and on the **General** tab, type a friendly name and description.
6. On the **Subject** tab, under **Subject Type**, choose **Common name** from the **Type** menu. Type a friendly name in the text box, choose **Add**, and then **Apply**.
7. On the **Extensions** tab, choose **Key usage** from the menu, add **Digital signature and Key encipherment** to the **Selected** options box.
8. On the **Extended Key Usage** menu, add **Server Authentication** and **Client Authentication** to the **Selected** options box.
9. On the **Private Key** tab and under the Key options menu, ensure that the Key size is 2048. Select the **Key Exportable** check box, and then **Apply**.
10. On the **Certification Authority** tab, ensure that the CA check box is selected, and then **OK > Enroll > Finish**.
11. In the **Certificates** console, select **Personal > Certificates**, choose the certificate you built. Select **All Tasks > Export > Next**, and select the **Yes, Export the Private Key** radio button, and then **Next**.
12. Under **Personal Information Exchange - PKCS #12(.PFX)**, select the check box to include all certificates, choose **Next**, create a password, and choose **Next**.
13. Click **Browse**, navigate to C:\\ls_cert and type server.PFX, and then follow the wizard to finish.

**Step 1, method 2 — obtain the .pfx file sending a request to a certificate authority (CA)**

These steps might vary based on your Certificate Authority.

1. Log on to the License Server, open the MMC, and follow these steps:
   a) Add the Certificate snap-in by selecting **File > Add/Remove Snap-in > Certificates > Computer account > Local computer**.
   b) In the left pane under **Certificates**, right-click **Personal** and choose **All Tasks > Advance Operations > Create Custom Request**, and then **Next**.
   c) In the **Certificate Enrollment Policy** wizard, choose **Proceed without enrollment policy under Custom Request**, and then **Next**.
   d) On the **Custom request screen**, choose **(No template) CNG key** from the menu and **PKCS#10** for the Request format, and then **Next**.
   e) On the **Certificate Information** screen, choose **Details** and then **Properties**.
   f) On the **General** tab, type a friendly name and description.
   g) On the **Subject** tab, under Subject name, choose **Common name**, and type a value in the text box.
   h) On the **Extensions** tab, choose **Key usage** from the menu, add **Digital signature** and **Key encipherment**.
   i) On the **Extensions** tab, choose **Extended Key usage** from the menu, add **Server Authentication** and **Client Authentication**.
   j) On the **Private Key** tab, under **Cryptographic Service Provider**, choose **RSA, Microsoft**
Software Key Storage Provider (the default). From the Key options menu, ensure that the key size is 2048, select the Key Exportable check box, and then Apply.

k) Save the file to a .req file, submit the .req file to a Certificate Authority (CA), and save the .cer file.

2. In the MMC, under Certificates, right-click Personal and choose All Tasks > Import. In the Import wizard, select the .cer file.

3. Create a directory c:\ls_cert to hold the exported .pfx file.

4. In the Certificates console, choose Personal > Certificates, and choose the certificate you imported. Select All Tasks > Export > Next, and select the Yes, Export the Private Key radio button and Next.

5. Under Personal Information Exchange - PKCS #12 (.PFX), select the check box to include all certificates, choose Next, create a password, and then choose Next.

6. Choose Browse, navigate to C:\ls_cert and type server.PFX, and then follow the wizard to finish.

Step 2 — extract the certificate and private key

This step requires OpenSSL or another tool that allows you to extract the certificate and private key from a .pfx file.

Important:
The version of OpenSSL shipped with the License Server does not support extracting certificates and private keys. For information about downloading OpenSSL, go to www.openssl.org. Citrix recommends installing OpenSSL on a separate workstation to perform these steps:

1. Navigate to the \openssl directory\bin folder.

2. Run openssl pkcs12 -in C:\ls\_cert\server.pfx -out server.crt -nokeys
   
   Note: The License Server uses only the .crt certificate format.

3. Type the password created during the export process (password).

4. Run openssl pkcs12 -in C:\ls\_cert\server.pfx -out server.key -nocerts -nodes

5. Type the password created during the export process (password).

Step 3 - install the .crt and .key files on the License Server

Windows - Web Services for Licensing:

1. Copy the server.crt and server.key created earlier in this procedure to cd \program files (x86)\citrix\licensing\WebServicesForLicensing\Apache\conf\.
2. Restart the Citrix Web Services for Licensing service.

**Windows - License Administration Console:**

1. Copy the server.crt and server.key created earlier in this procedure to `c:\Program Files (x86)\Citrix\Licensing\LS\conf`.
2. Restart the Citrix Licensing service.

**Configure a proxy server for Citrix Licensing Manager, Customer Experience Improvement Program (CEIP), and Call Home**

You can use a proxy with the Citrix Licensing Manager, CEIP, and Call Home. When you configure a proxy server, requests to download licenses and upload Call Home data are sent through a proxy server.

**Important**

Citrix Licensing components requiring outward bound web communications can inherit network proxy settings using Windows automatic proxy detection. We do not support authenticated proxies. For more information about Windows automatic proxy detection, see [WinHTTP AutoProxy Functions](#).

**Configure a proxy server manually:**

1. Edit the `SimpleLicenseServiceConfig.xml` file, which is in the `<Citrix Licensing >\WebServicesForLicensing` directory.
2. Add a line of xml to the file in the format `<Proxy>proxy server name:port number</Proxy>`

**Important:** The .xml tags are case-sensitive.

```
<Configurations>
  <EncoreConfiguration>
    <SamplingPeriod>15</SamplingPeriod>
    <RetentionTime>180</RetentionTime>
    <Enabled>true</Enabled>
  </EncoreConfiguration>
  <Proxy>10.211.55.5:808</Proxy>
</Configurations>
```

**Upgrade the License Server**

October 7, 2019
Each time you upgrade your Citrix product, also upgrade the Citrix License Server. Each time a new License Server is released, it might contain better security, fixes to known issues, and so on.

Sometimes, new versions of the Citrix product are incompatible with older versions of the License Server. New versions of the License Server are compatible with older versions of the product and old licenses.

Customer Success Services members are eligible for version upgrades to the latest release of Citrix products and to upgrade existing licenses to the license system used by these products.

Version upgrade
means the movement from any previous version of a product to the newest version of the product. For example, moving from XenDesktop 7.18 to Citrix Virtual Desktops 7.1909.

Edition upgrade
means the purchase of a higher edition level of a product. For example, you now have Advanced Edition and you purchase an upgrade to Platinum Edition.

How to upgrade the License Server

Citrix recommends that you install the newest License Server. The new License Server is backward compatible and supports older products and license files. However, new products require the newest License Server to check out licenses correctly. You can install or upgrade the latest version from the Citrix website (Downloads page).

Upgrade your licensing components before upgrading your product, if necessary.

Uninstall any versions of Citrix Licensing older than version 11.12.1 before installing this version.

Use the new CitrixLicensing.exe file for all future installations and upgrades, except for Active Directory deployments. In that case, use the .msi. Ensure that both .exe and .msi files are present for the installation.

Unsure which version of the License Server you have? See Ensure you have the latest License Server.

For information about system requirements, see System requirements.

Important
To avoid the failure of any subsequent License Server upgrades: Ensure that when you installed your License Server, you successfully configured it with the post installation License Server Configuration tool or uninstalled your previous License Server.

To upgrade the License Server:

Download the license components on the Citrix website Downloads page, start the License Server installer (CitrixLicensing.exe) as an administrator, and follow the graphical interface.
To upgrade the License Server from your product media:

If you use the product media for your installation, you might have to enable some functionality by using the Citrix Licensing Manager after your installation. For example, use the Citrix Licensing Manager to enable Customer Success Services renewals.

1. From your License Server, open the media for your product.
2. If you do not see Setup, use Windows Explorer to open Autorun.exe or AutoSelect.exe.
3. Navigate through the Setup screens to Citrix Licensing and follow the instructions.

To upgrade the License Server from the command line:

Ensure that you run the command line with administrator privileges. To start the command prompt with elevated privileges, choose Start, right-click Command Prompt, and choose Run as administrator.

You cannot change ports during a command line upgrade.

The following sample command line installs licensing in silent mode.

`CitrixLicensing.exe /quiet /install.log INSTALLDIR=installdirectory CEIPOPTIN=ANON`

- `/quiet` specifies a silent (quiet) installation.
- `/install.log` specifies the log file location
- `INSTALLDIR` is the location where the License Server executable is stored. Optional parameter. The default is `c:\program files\citrix licensing or c:\program files (x86)\citrix\licensing`.
- `CEIPOPTIN` specifies whether, or how, to opt in to Citrix Customer Experience Improvement Program (CEIP) or Call Home. Optional parameter. The default is `ANON`.
  - `DIAG` - Call Home
  - `ANON` - CEIP
  - `NONE`

You can modify the CEIP and Call Home choice using the Citrix Licensing Manager.

**Important**

The Citrix Service Provider program requires Customer Experience Improvement Program (CEIP) and Call Home. If you are a Citrix Service Provider, you cannot disable CEIP or Call Home.

Upgrade licenses for your edition

If you are eligible for a version upgrade as a benefit of your maintenance, you can obtain a new license and add it to the License Server. Also change the product edition setting in the product user interface. It’s best to change the product edition setting when there are few connections to the affected servers or redirect connections to another computer. When you change the product edition setting, restart the product server for changes to take effect. See the product documentation for changing the edition
setting. If you add the upgrade license to the License Server before you set the edition to the new edition, the Citrix product stops accepting new connections.

Note
Licenses from old product editions display on the Dashboard of the License Administration Console even though they are no longer valid. If you do not remove obsolete or unnecessary license allocations, you might see persistent alerts regarding the Customer Success Services expiration dates of these licenses. You cannot disable these alerts. The only impact of leaving obsolete license allocations on License Servers is that you continue to receive these alerts. If you want to delete the licenses, see “Delete license files” in Administration without a console.

To upgrade edition licenses:

2. Choose Log In and type your user ID and password.
3. Select Manage Licenses.
4. At the bottom of the landing page, select Upgrade my licenses.
5. Follow the site options and instructions for upgrading your product edition licenses.
6. Either download or order new media. An email message provides you with instructions to return to citrix.com to allocate or receive more feature licenses.
7. Log on to www.citrix.com to allocate your licenses, generate a license file, download the license file to your License Server, and reread the file.

Prerequisites to obtain your license files

June 14, 2019

After you install the licensing components, you are ready to obtain your license files.

You can obtain your license files in several ways:

- Studio in Citrix Virtual Apps and Desktops. For more information, see Licensing in the Citrix Virtual Apps and Desktops documentation.
- Citrix Licensing Manager
- License Administration Console
- citrix.com

Before going to the Citrix website, you need the following information at hand:

- Your user ID and password for My Account. You can register for this password on My Account.
- The license code. Find this code at My Account on citrix.com or in an email you receive from Citrix.
Note: If you cannot locate these items, contact Citrix Customer Service.

- **The host ID of the server on which you installed the licensing components.** The entry field for this name is case-sensitive, so ensure that you copy the name exactly as it appears on the computer.

  You can find the License Server host name and MAC address (Ethernet) in the License Administration Console. The information is in the Administration area on the System Information tab. You can also run the host name command at a command prompt on the License Server.

- **How many licenses you want to include in the license file.** You do not have to download all the licenses you are entitled to at once. For example, if your company purchases 100 licenses, you can allocate and download only 50 now. Later, you can allocate the rest in another license file. You can have more than one license file.

### Citrix Licensing Manager

September 18, 2019

The Citrix Licensing Manager enables the following features on a License Server using a simple web interface:

- Dashboard that displays installed, in-use, expired and available licenses, and Customer Success Services dates.
- Short code registration of the License Server to Citrix Cloud and easy removal of registration.
- Force data uploads to Citrix.
- Enhanced user/device license usage reporting.
- Register your License Server with Citrix Cloud.
- Configure user and group accounts.
- Simplify data export by allowing you to select all products, all license models, and all Customer Success Services (Subscription Advantage) dates.
- Enable and disable the supplemental grace period.
- Change these ports:
  - License Server (default 27000)
  - Vendor Daemon (default 7279)
  - Web Services for Licensing (default 8083)
- Configure historical data retention by selecting a retention period. Default data retention is 180 days.
- Displays the License Server version in the top bar of the screen. If you select the down arrow, the host name, Ethernet address, and IPvr address appear.
• Simplified installation of license files on the License Server using a license access code or downloaded file.
• Display details of licenses after they are installed.
• Configure Citrix Customer Experience (CEIP) and Call Home at any time.
• Retry failed citrix.com and Customer Experience Improvement Program uploads.
• Configure Customer Success Services renewal license actions. You can specify whether to check automatically or manually for renewal licenses and whether you want notification of renewal licenses or the licenses installed. For more information on configuring this feature, see Check for and install Customer Success Services renewal licenses with the Citrix Licensing Manager.
• Store and export historical usage reports from the License Server on which the tool is installed. You can specify a date range for the historical usage data and export it to a CSV file. The CSV file provides daily usage information including the number of licenses in overdraft. For information about exporting historical usage data, see Export historical usage data by using the Citrix Licensing Manager.
• Important notifications of license availability, expiration, and other conditions. Use the bell icon at the top of the Citrix Licensing Manager screen to display notifications.

The Citrix Licensing Manager operates automatically within the License Server for Windows.

Licensing Manager appears.

Install licenses

June 14, 2019

Install licenses

Considerations - Be aware of these considerations when using the Citrix Licensing Manager to allocate and download licenses:

• The License Server requires internet access or configuration with a proxy server.
• After you click Allocate and Download, you cannot cancel it. If the Allocate and Download fails, use My Account at citrix.com.
• The Citrix Licensing Manager allocates most license access codes but doesn’t support redownloading or reallocating of license files. You can return licenses on citrix.com and use the Citrix Licensing Manager to allocate them again. For redownloading, use My Account.
• If you rename the License Server, you must reallocate any license files allocated under the old License Server name.
• The Citrix Licensing Manager gives you the option of choosing how to obtain your licenses:
  – Use license access code
- **Use downloaded license file**

In the **Start** menu, click **All Programs > Citrix > Citrix Licensing Manager** or from a remote machine use this URL with your actual License Server name **https://licenseservername:8883**.

**Use license access code:**

1. Select **Use license access code** and type the license access code (which is supplied in an email from Citrix) and choose **Display Licenses**. Your license entitlements display and you can choose which licenses and the quantity to install.

2. Select a product from the displayed list, type the number of entitlements to install, and choose **Install**. To select more than one product, choose a product, click Install, choose the next product, click Install, and so on. They are processed in order. After you install all the licenses for a specific license access code, you cannot use that license access code again. If you must perform more transactions with that code, log on to **My Account**.

3. To display the newly downloaded licenses, refresh the License Administration Console.
Select **Use downloaded license file**, choose a file, and check the check box if you want to replace and older file with the same name.

2. Click **Import**. The Citrix Licensing Manager displays information about the licenses.

3. If your license file is successfully uploaded to the License Server, a message displays. To display the newly downloaded licenses, refresh the License Administration Console.

**Tip**

If you experience issues uploading a license file, remove any special characters in the file name.
Licensing

and ensure that the file has a .lic extension (all lower case).

Dashboard

September 18, 2019

The Citrix Licensing Manager dashboard displays the following information about your licenses:

- Product-edition
- Model
- In use/installed
- Available

To get more detailed information for the licenses for a particular product, click the > on the right side of the screen. The Citrix Licensing Manager displays a table containing:

- Customer Success Services (CSS) date
- Total licenses installed
- Overdraft
- Licenses in use
- Available licenses
- Expiration date
- Type

The dashboard data updates every five minutes.
The Citrix Licensing Manager stores and exports historical usage reports from the License Server on which you've installed the tool. You can specify a date range for the historical usage data and export it to a CSV file. The CSV file provides daily usage information, including the number of licenses in

### Historical usage

**May 31, 2019**

The Citrix Licensing Manager stores and exports historical usage reports from the License Server on which you’ve installed the tool. You can specify a date range for the historical usage data and export it to a CSV file. The CSV file provides daily usage information, including the number of licenses in
You can also view and specify the amount of time to retain the data.

**Export historical usage data**

1. Log on to the Citrix Licensing Manager hosted on the License Server. Type this URL into a browser on a system having access to the License Server. Use your actual License Server host name.

   \[ \text{http://License-Server-Hostname:8083/} \]

2. Use the menus, select the product and edition, the license model, and the date range (larger the better) to gather the history.

3. After making your selections, choose Export, and the browser download dialog displays.

4. Use the Save menu, choose Save As to save the exported .CSV file.

5. To change the retention period, choose Change, and then make the change using the menu.

If you have multiple Customer Success Services dates, you can choose All.

The default retention period is 180 days.
Update licenses

May 2, 2019

You can check for available Customer Success Services renewal licenses. When licenses are available, the list of licenses, quantity, and Customer Success Services date display on this screen. You can download and install the licenses. This screen lists any licenses installed in the last 30 days.

Settings

November 15, 2019

Display the Settings by clicking the Settings gear icon on the top of the screen. There are three types of settings:

- Account
- Server configuration
- Usage and statistics

Account

By using this screen, you can do the following:
Configure the user and group access to manage the License Server.

The Citrix Licensing Manager can use local Windows users and groups and Active Directory users and groups. Users configured here can access the Citrix Licensing Manager and the Citrix License Administration Console.

Active Directory users and groups are part of an Active Directory/network authentication system. To support them, ensure that the Windows License Server is a member of a Microsoft Active Directory domain and running the Citrix Licensing Manager.

Users are configured with local roles. All users created as administrators can:

- Select a console display language.
- View system information.
- Add and remove users.
- Configure the License Server port.
- Configure the vendor daemon port.
- Configure the Web Services for Licensing port.
- Configure and add licenses.

A default administrator account is created during the installation of the Citrix Licensing Manager. Use
the administrator account to first log on to the console and then configure more users.

**Server configuration**

By using this screen, you can do the following:

- Configure the License Server, vendor daemon, and Web Services for Licensing ports.
- Configure Customer Success Services renewal license actions.
- Enable and disable the supplemental grace period.
- Select the console display language.
Configure port numbers

You can edit the three default ports:

- **License Server.** This port number is used by the License Server Manager. License Server Manager handles the initial communication among the products, starts the vendor daemon, and relays check out and check in requests to the vendor daemon. By default, this port number is 27000.

- **Vendor Daemon.** This port number is used by the CITRIX vendor daemon. The vendor daemon is responsible for the core operations of the License Server, including license allocation. By default, this port number is 7279. However, if you have a firewall or if the number is already in use, you might need to change the port number.

- **Web Services for Licensing.** Port used by the Web Services for Licensing. The Web Services for Licensing hosts the Citrix Licensing Manager, so users connecting to Citrix Licensing Manager use this port. Director and Studio use this port to communicate with the License Server using Web Services for Licensing. By default, this port number is 8083.

Check for and install the Customer Success Services renewal

When enabled, the Citrix Licensing Manager contacts Citrix.com web services weekly to check for available Customer Success Services renewal licenses.

Based on how you configure it, the Citrix Licensing Manager automatically or manually checks for Customer Success Services renewal licenses. It notifies you or installs the licenses when found.

1. In the Citrix Licensing Manager, choose the settings icon on the upper bar of the UI.
2. Select how you want to be notified and if you want renewal licenses to be installed automatically, and then choose **Save**.

If the automatic checks for Customer Success Services renewal licenses fail, check the firewall setting or configure a proxy. For this feature to work, the License Server must be able to access https://citrixservices.citrix.com.

- **Automatically check for Customer Success Services renewal licenses and notify when available:** Citrix Licensing Manager displays a notification. Click a link to download and install available renewals. This same notification appears in Studio and Director if they are configured to manage the License Server.

- **Automatically check for and install Customer Success Services renewal licenses when available:** Citrix Licensing Manager checks weekly and automatically installs renewal licenses when available. A notification displays for a few days stating that renewals have been installed.

- **Manually check for Customer Success Services renewal licenses:** Select the **Update License** tab and Check for Available Renewals. You can check the **Update License** tab at any time to see
a list of licenses installed in the last 30 days.

**Supplemental grace period**

Specify whether to start the 15-day supplemental grace period when you reach the regular license consumption limit. For more information, see “Supplemental grace period” in the Technical overview article.

**Change the default and display language**

You can change the default language of the Citrix Licensing Manager display. The default applies to all console users. Available languages include:

- Chinese (Simplified)
- English
- French
- German
- Japanese
- Spanish

**Usage and statistics**

By using this screen, you can do the following:

- Configure how you share usage statistics with Citrix.
- Use an 8-digit code to register your License Server with Citrix Cloud and find out if your License Server is registered with Citrix Cloud.
- Learn how to register your License Server with Citrix Cloud and find out if your License Server is registered with Citrix Cloud.
- Know the status of your uploads. If uploads fail, information appears with suggestions to fix the issues.
- Force a data upload to Citrix.
- Set the period to retain the historical usage information. The default is 180 days.

**Register and remove registration with Citrix Cloud**

The Usage and Statistics section of the Settings screen includes short-code activation to easily register your Citrix License Server with Citrix Cloud. When you have done that, this screen indicates that you are registered.

Use the same screen to remove your registration.
When you register the License Server with Citrix Cloud, the License Server collects and stores the Call Home license usage information. The License Server regularly transmits that data to Citrix Cloud.

Important:
Before registering your License Server with Citrix Cloud, use firewall rules to open these URLs:

https://trust.citrixnetworkapi.net
https://trust.citrixworkspacesapi.net/

Register:
1. On the Usage and Statistics screen, click **Register** and an 8-character alphanumeric code is generated.

![Citrix Licensing Manager](image)

![Use this code to register this License Server with Citrix Cloud](image)

2. Select **View details** to see your License Server version, MAC ID, host name, and IP address.
3. Click **Register** and you’re taken to the Citrix Cloud log on page.
4. Type your valid Citrix Cloud credentials and you are taken to the **Product Registration > Register**.
5. Paste in the same 8-character alphanumeric code, and click **Continue**.
6. Review the registration details and then click **Register**.

Note:
If you’re not redirected to the Product Registration experience, do the following:
Licensing 11.16.3

1. Go to citrix.cloud.com and log on.
2. Select your company, and select menu > Identity and Access Management > API Access tab > Product Registrations.

For more information, see Register on-premises products with Citrix Cloud.

Your License Server registered successfully in Citrix Cloud. You can view the details in the Citrix Cloud UI.

Remove registration:

There are reasons that you might want to remove the License Server registration with the Citrix Cloud. For example, you've registered your License Server to Company A, which is now merged into another organization. You want to consolidate your license usage data into one Citrix customer account. To do that, remove your registration, and then register with a new Citrix Cloud account.

1. On the Usage and Statistics screen, click Remove Registration.

2. On the Remove Registration confirmation modal, click Remove Registration to confirm removal from the Citrix Licensing Manager.

3. To complete the registration removal process, you have to remove the registration on Citrix Cloud. Go to the Citrix Cloud log on page.

4. Type your valid Citrix Cloud credentials and select Identity and Access Management in the
Citrix Cloud menu.

5. Navigate to the **API Access** tab, click **Product Registrations**, select the product by clicking the dots on the product line, and click **Remove registration**.

6. In the confirmation modal, click **Remove**.

Your registration is removed from Citrix Cloud.

**Share usage statistics**

The Citrix Licensing CEIP and Call Home usage and analytics programs are voluntary data collection programs designed to improve your product experience. You can participate in the programs anonymously, choose to be identified, or decline to participate.

**Important**

The Citrix Service Provider program requires CEIP and Call Home. If you have Citrix Service Provider licenses installed, you can change the settings, but you cannot disable CEIP or Call Home.

**Upload now**

The **Usage and Statistics** section of the **Settings** screen includes **Upload now**. When you enable CEIP, use **Upload now** to force a data upload to Citrix. Wait five minutes between uploads.
Settings

Share usage statistics with Citrix

Help us improve Citrix products by providing License Server and basic usage statistics.

- Allow Citrix Insight Services to safely collect basic usage and statistical information to better understand customer usage.

Steps to register

- In the License Server console, run the executable RegisterLSToCloud.exe. The file is located at: C:\Program Files (x86)\Citrix\licensing\dumps\_source
- Provide Citrix Cloud Credentials to login
- Select Customer

- Send anonymous statistics and usage information to the Citrix Customer Experience Improvement Program (CEIP).
- Do not send any data to Citrix.

Upload information

Provides status for the last Citrix Customer Experience Improvement Program (CEIP), Call Home, or Citrix Service Provider Program upload.

Last successful upload: 16/11/2018 3:08:15 PM

Upload now

Historical Use

Retention Period: 180 Days
Upload information

This section provides status for the last CEIP, Call Home, or Citrix Service Provider upload. If the upload fails, the Citrix Licensing Manager displays troubleshooting information.

You can force a data upload to Citrix without waiting for the daily upload. The only restriction is that you wait five minutes between uploads.

Historical usage retention

Set the amount in days to retain your License Server usage information.

License Administration Console

October 7, 2019

The License Administration Console lets you manage and monitor your Citrix licenses through a web browser.

Use the Dashboard to:

• Monitor licenses, license activity, and alerts
Use the Administration area to:

- Administer licenses
- Configure alerts
- Import licenses
- Log license management activities
- Secure the console server
- View system information

**Important**

The Licensing Administration Console no longer supports user configuration. User Configuration has been moved to the **Citrix Licensing Manager > Settings > Accounts**. For more information, see **Settings**.

**What types of accounts are added at installation**

A default administrator account is created during the installation of the License Administration Console. Use the administrator account to first log on to the console and then configure more users.

During the installation of the License Administration Console, accounts are added based on the machine membership. For workgroup machine installations, `computer\InstallUser` and `BUILTIN\Administrators` are added. For Active Directory installations, `domain\InstallUser**` and `BUILTIN\Administrators` are added. You can remove any of these accounts after installation, but ensure that there is at least one administrator.

Toggle between the Dashboard and Administration views from links in the top right area of the console. Access to the Administration area requires administration privileges and is password-protected.

**Open the console on a Windows computer**

To open the **License Administration Console** on the computer on which it is installed:

From the Start menu, choose **All Programs > Citrix > License Administration Console**.

**Open the console on a remote server or cluster**

Navigate your browser to one of the following URL options:

- `https://License Server name:Web service port`
- `https://Client access point name:Web service port`
- `https://IP:Web service port`

Where:
• License Server name is the name of your License Server
• Client access point name is the name given to the client access point during the cluster configuration
• IP is the IP address of the License Server
• Web service port is the port number for the console web service

The default web service port for the console is 8082.

Update the License Administration Console UI

If you added license files with the console, you must update the console UI after removing those files.

1. Start the console and select Administration.
2. Log on as an administrative user and select the Vendor Daemon Configuration tab.
3. Select the Citrix vendor daemon from the list.
4. Edit the contents of License File or Directory to remove any deleted licenses and then save the configuration.

Note

When you start the License Administration Console, a blank page might appear. This issue can occur if the Internet Explorer Enhanced Security Configuration is enabled and the License Administration Console is not in the Trusted Sites. Disable Internet Explorer Enhanced Security Configuration and the License Administration Console appears.

Import license files

June 14, 2019

After generating your license file from citrix.com, you are ready to import it into the License Server. A startup license is imported during the License Server installation to allow Citrix products to communicate with the License Server.

Important

We recommend that you use the Citrix Licensing Manager to import license files. For more information, see Install licenses.

Ensure that the license file retains the lower case .lic file name extension. Some copy processes do not recognize a file type for that extension and add a .txt file name extension during the copy. The License Server cannot import license files that have the wrong file name extension.

1. From a web browser, go to https://ls:8083.
2. Select **Administration** and **Vendor Daemon Configuration**.

3. Click **Import License**.

4. Select the **citrix.com** link.

5. On the **My Account** page, type your user ID and password.

6. Select **Manage Licenses**.

7. Select the licenses you want to allocate. The landing page displays only new licenses within 30 days and expiring term licenses. You can use the **Filter by** menu to search for specific types of licenses or select **Quick find: All active** to see all licenses.

8. From the **Select an action** menu, choose **Allocate licenses**. Follow the process to allocate and download your license file, and save the file to a temporary directory.

9. Select the licenses you want to download, click **Download**, and save the file to a temporary directory.

10. In the License Administration Console on the **Import License File** page, browse to the license file.

11. If you copied the file directly to the MyFiles directory, or if a file having the same name exists on the License Server, select **Overwrite License File on License Server**.

12. Select **Import License**.

13. Select **Vendor Daemon Configuration** and select **Administer** in the Citrix vendor daemon line.

14. Select **Reread License Files** to allow the License Server to recognize the new file.

Users can begin using these licenses when the License Server reads the licenses.

### Change port numbers

**June 14, 2019**

Licensing installation sets several port numbers for communications. After installation, you can use the License Administration Console to change port numbers.

- **Console Web Server Port**: The HTTPS TCP/IP port that the web server uses to listen for communication with clients connecting to the License Administration Console. By default, the port is set to 8082. If you are already using that port number for another application, you can change it to a range between 1 and 65535. If you are upgrading, you maintain your previous configuration and might not get HTTPS by default. If you change the port, you must stop and restart the Citrix Licensing service.
• **License Server Manager Port**: This port number is used by the License Server Manager. License Server Manager handles the initial communication among the products, starts the vendor daemon, and relays check out and check in requests to the vendor daemon. By default, this port number is 27000. **Tip**: You can verify which port number is being used from the System Information tab in the Administration area.

• **Vendor Daemon Port**: This port number is used by the Citrix vendor daemon. The vendor daemon is responsible for the core operations of the License Server, including license allocation. By default, this port number is 7279. However, if you have a firewall or if the number is already in use, you can change the port number. **Tip**: You can verify which port number is being used from the Vendor Daemon Configuration tab in the Administration area.

The License Administration Console replaces the License Server Port Utility for changing port numbers. The License Server Port Utility was used to change port numbers before this functionality was developed in the License Administration Console.

**To change the console port**

1. In the top right corner of the console, select **Administration**.
2. Click the **Server Configuration** tab.
3. Click the **Web Server Configuration** bar.
4. In the **HTTPS Port** field, modify the current port number and click **Save**.
5. In the host machine operating system, open the **Services** panel and select the **Citrix Licensing service**.
6. Restart the **Citrix Licensing service**.

**To change the License Server port**

This procedure changes the port number used by the License Server Manager (lmadmin.exe).

1. In the top right corner of the console, select **Administration**.
2. Select the **Server Configuration** tab.
3. Click the **License Server Configuration** bar to display the associated options.
4. Select the **Use this Port** radio button and type the new port number in the adjacent field. Click **Save** to save the new port number.
5. Restart the **Citrix Licensing service**.

**To change the vendor daemon port**

1. In the top right corner of the console, select **Administration**.
2. Select the **Vendor Daemon Configuration** tab.
3. Select the Citrix vendor daemon from the table.
4. Under the Vendor Daemon Port, set the new port number.
5. Click Save.
6. Restart the Citrix Licensing service.

Change the default and display language

May 23, 2019

Change the default language

Administrators can change the default language of the License Administration Console display. The default applies to all console users. Available languages include:

- Chinese (Simplified)
- English
- French
- German
- Japanese
- Spanish

Users can set a display language for their session. The console display reverts to the default language at the end of each user session.

1. Select Administration and choose the Server Configuration tab.
2. Click the User Interface bar.
3. From the Default Display Language list, choose a language.

Change the display language

You can customize your user session by changing the console display language. The console language reverts to the default when you log off. You can change the display language:

Select the language you want:

- When prompted during logon.

Or

- By clicking Change Display Language at the bottom left corner of the console
Improve performance by specifying thread use

June 14, 2019

Requests come in to the License Server through a listener port. An acceptance thread must accept all communication. If the message is accepted, a receive thread handles it and then a processing thread processes it. To improve License Server performance when receiving many requests, you can configure the maximum number of receive and processing threads to use.

When a program starts an I/O request (an example would be a request to check out a license), it creates and uses a thread. The thread maintains the place and data in the program as a reference point. After the request is complete, the program can be reentered at the same point. You can have many requests at the same time, depending upon how many threads are allowed. This technique is called multithreading.

The optimal values needed for acceptable License Server performance dependent on the hardware, the site configuration, and the request volume. If you set the limits too high and your hardware cannot support it, it slows down the communication. If you set the limits too low, it takes longer for the communication to occur. The system waits until it can create more threads before it executes incoming requests. Test and evaluate different values to determine the configuration that meets your site needs. A good starting point for a large-scale deployment might be setting:

- Maximum Number of License Server Manager Processing Threads to 30.
- Maximum Number of License Server Manager Receiving Threads to 15.

There are two areas where you can specify the thread limits:

- License Server
- Web server

Set License Server thread use

1. In the top right corner of the console, select **Administration**.
2. Select the **Server Configuration** tab and the **License Server Configuration** bar.
3. Change the **Maximum Number of License Server Manager Processing Threads** and **Maximum Number of License Server Manager Receiving Threads** fields (up to 999 threads).
4. Restart the Citrix Licensing service.

Set web server thread use

Use this procedure to set the maximum number of threads that the web server for the License Administration Console uses to process requests. Specify a larger number if you expect many users to access
the console simultaneously.

1. In the top right corner of the console, click **Administration**.
2. Click the **Server Configuration** tab and the **Web Server Configuration** bar.
3. Modify the **Maximum Number of Web Server Threads field** (up to 999 threads).
4. Restart the Citrix Licensing service.

### License administration

May 23, 2019

After you have imported your license files, the Citrix vendor daemon (CITRIX) administers them. The Citrix vendor daemon is responsible for core operations of the License Server, such as tracking the number of checked out licenses and who has them. The vendor daemon can manage all your Citrix license files and it is fully backward compatible with any license files you have. Set properties for the vendor daemon on the **Vendor Daemon Configuration** screen of the console.

**Important**

You can manage only the Citrix vendor daemon by using this console. We don’t support running the Citrix vendor daemon on non-Citrix license servers.

### Configuring the vendor daemon

The **Vendor Daemon Configuration** screen allows you to import license files, configure the vendor daemon, and view logs about the license activity. Only users that have administrator privileges can view this screen.

Select **Administer** in the vendor daemon summary grid to set these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Daemon Port in Use</td>
<td>The TCP/IP port number that the vendor daemon uses for communication with products.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the vendor daemon, but leaves the console running. When you stop a vendor daemon, <strong>Stop</strong> changes to <strong>Start</strong>. Disabled by default.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Start</td>
<td>Starts the vendor daemon and reads the license files. <strong>Start</strong> only appears when the vendor daemon is stopped. <strong>Start</strong> changes to <strong>Stop</strong>.</td>
</tr>
<tr>
<td>Reread License Files</td>
<td>Rereads the contents of the license files and the options file.</td>
</tr>
<tr>
<td>Report Log Name</td>
<td>This option is not functional.</td>
</tr>
<tr>
<td>Rotate Report Logs</td>
<td>This option is not functional.</td>
</tr>
</tbody>
</table>

**Monitor licenses and alerts**

June 14, 2019

Use the Dashboard to monitor your license activity. The Dashboard is the default view when you open the License Administration Console.

**License status at a glance**

The Dashboard presents a synopsis of your licenses:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Product, edition, and type of license.</td>
</tr>
<tr>
<td>CSS Date</td>
<td>The Customer Success Services membership expiration date for the product license.</td>
</tr>
<tr>
<td>In Use (Available)</td>
<td>The number of licenses now in use, followed by the total number available for use.</td>
</tr>
<tr>
<td>Expiration</td>
<td>The date the license expires.</td>
</tr>
<tr>
<td>License Type</td>
<td>The type of license, such as concurrent user or system licenses.</td>
</tr>
<tr>
<td>Hosts</td>
<td>The Hosts link appears when licenses are checked out and links to a list of the host names with licenses in use.</td>
</tr>
</tbody>
</table>


About alerts

Licensing events such as the License Server stopping or the expiration of a Citrix Customer Success Services membership trigger dashboard alerts. You configure alerts in the Administration area. The list of displayed alerts is updated when the Dashboard page is reloaded or refreshed.

Alerts about concurrent licenses are tested and triggered at one-minute intervals. The “Vendor Daemon Down” alert is triggered immediately.

There are two types of alerts:

Critical alerts

<table>
<thead>
<tr>
<th>Dashboard Alert</th>
<th>Administration Name</th>
<th>Triggering Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>The vendor daemon has stopped</td>
<td>Vendor daemon down</td>
<td>The License Server stops, unexpectedly or purposely stopped by the administrator.</td>
</tr>
<tr>
<td>The concurrent license has expired</td>
<td>Out of concurrent licenses</td>
<td>All the concurrent licenses have been checked out.</td>
</tr>
<tr>
<td>Licenses for product_name have expired</td>
<td>Concurrent license expired</td>
<td>The license has expired. If the license is not a type of license covered by Customer Success Services, there is no deleterious effect from being expired. For example, the startup license and evaluation licenses are always “expired” because they are not covered by Customer Success Services. You can ignore this alert unless it is for a license that shows an expired Customer Success Services date in the dashboard.</td>
</tr>
<tr>
<td>Customer Success Services membership expired</td>
<td>Customer Success Services membership expired</td>
<td>The Customer Success Services membership for a concurrent license has expired.</td>
</tr>
</tbody>
</table>
### Important alerts

<table>
<thead>
<tr>
<th>Name of Alert</th>
<th>Triggering Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concurrent threshold exceeded</td>
<td>A percentage (specified by the administrator) of concurrent licenses have been checked out.</td>
</tr>
<tr>
<td>Concurrent license expiring</td>
<td>Some days (specified by the administrator) remain before the concurrent license expires.</td>
</tr>
<tr>
<td>Customer Success Services membership expiring</td>
<td>Some days (specified by the administrator) remain before the Customer Success Services membership for a license expires. If the license is not a type of license covered by Customer Success Services, there is no deleterious effect from being expired. For example, the startup license and evaluation licenses are always “expired” because they are not covered by Customer Success Services. You can ignore this alert unless it is for a license that shows an expired Customer Success Services date in the dashboard.</td>
</tr>
</tbody>
</table>

### To view alerts

1. On the Dashboard, click the red X icon to view critical alerts or the orange! icon to view important alerts.
2. Click items in the list to see their details.

### To clear alerts

Alerts are not cleared automatically when the condition changes. Clear the alert manually to delete it from the list.

Click the X icon next to the alert item.
Security

June 14, 2019

Steps you can take to secure the License Administration Console and Web Services for Licensing:

• Use HTTPS for the console web server communications - HTTPS is the default for new installs. If you are upgrading, using HTTPS might be required.
• Require users to log on to the Dashboard.
• Specify a user session timeout.
• Change your console password.

Use HTTPS to configure a server certificate file and key file

• For new installations, the License Server uses HTTPS by default for both the License Administration Console (port 8082) and for Web Services for Licensing (port 8083).
• The web browser uses the License Administration Console and Citrix Licensing Manager.
• The Delivery Controller, Studio, and Director use Web Services for Licensing.
• For HTTPS, the License Server selects TLS 1.0, TLS 1.1, or TLS 1.2, as determined by the web browser, Delivery Controller, Studio, or Director.

Configuration of TLS version or TLS cipher suites within the License Server itself is not supported.

If you use HTTPS, you must have a valid server certificate. We generate a self-signed certificating during installation, but you can create your own. For more information, see Manually install a certificate used by the Citrix Licensing Manager and Web Services for Licensing.

To require users to log on to the dashboard

You can optionally secure the Dashboard by forcing users to type a password. The Administration area is password-protected for all users.

1. Select Administration and choose the Server Configuration tab.
2. Select the User Interface bar.
3. Select Require user to log on to view Dashboard.

To specify a session timeout

You can log out users after a specified time of inactivity, ensuring they do not leave the console unattended.

1. Select Administration and choose the Server Configuration tab.
2. Select the **Web Server Configuration** bar.

3. For **Session Timeout**, type the number of minutes that a user can remain inactive before being logged out of the console. The maximum value is 99999 (69 days, 10 hours, 39 minutes).

### Change your console password

You can change your License Administration Console password at any time.

**Note:** The Windows License Server does not support changing Active Directory user and local Windows user passwords. Active Directory users and local Windows users can change their passwords using their native operating systems. On Windows, if you log on as a Locally Managed user and then log on, the **Change Password** link displays at the bottom right corner.

If you log on as a Windows **Active Directory user/admin**, the **Change Password** link does not display at the bottom right corner. It doesn’t support Active Directory users.

1. In the bottom right corner of the console, select **Change Password**. If you do not see the link, it is because you are in the Dashboard area and you are not required to type your credentials. Clicking the **Administration** option causes the link to appear.
2. Type your old password.
3. Type to enter and confirm your new password.

If you forget your password, contact the console administrator to assign you a new one.

### System information, logs, and alerts

**June 20, 2019**

**System information**

You can view system information about the License Server and the system running the License Server. The following information is available by selecting the **Administration** option in the top right corner of the License Administration Console, followed by the **System Information** tab.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release Version</td>
<td>The version of the License Server.</td>
</tr>
<tr>
<td>License Server Manager Port Number in Use</td>
<td>The port number that the License Server uses to communicate with the products.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display</td>
<td>On Windows, the display is the system name or the terminal server client name (in a terminal server environment). On UNIX, the display is the X-Display name or the value returned by the ttynamel() (or comparable) function.</td>
</tr>
<tr>
<td>Host Name</td>
<td>The name of the computer hosting the License Server.</td>
</tr>
<tr>
<td>Host Domain Name</td>
<td>The fully qualified name of the computer hosting the License Server.</td>
</tr>
<tr>
<td>IPv4 Address</td>
<td>The IP version 4 address of the computer hosting the License Server. The IPv4 address appears only if the computer has IPv4 enabled.</td>
</tr>
<tr>
<td>IPv6 Address</td>
<td>The IP version 6 address used to identify the computer hosting the License Server. The IPv6 address appears only if the computer has IPv6 enabled.</td>
</tr>
<tr>
<td>Ethernet Address</td>
<td>The Ethernet address (also known as the MAC address) of the computer hosting the License Server.</td>
</tr>
<tr>
<td>Local Stop Server Allowed</td>
<td>Displays yes or no. If it is no, you cannot stop the License Server using the <code>lmdown</code> utility or the console. Configure this property using the -allowStopServer command-line option when you run the License Server manager (<code>lmadmin</code>). Disabled by default.</td>
</tr>
<tr>
<td>Remote Stop Server Allowed</td>
<td>Displays yes or no. If it is no, you cannot stop the License Server from a remote machine using <code>lmdown</code> or the console. Disabled by default.</td>
</tr>
</tbody>
</table>

**Logs**

Log files are stored in:

- `C:\Program Files\Citrix\Licensing\LS\Logs` on a 32-bit server
- `C:\Program Files(x86)\Citrix\Licensing\LS\Logs` on a 64-bit server
• C:\Program Files (x86)\Citrix\Licensing\WebServicesForLicensing\Logs on a 64-bit server

<table>
<thead>
<tr>
<th>Log</th>
<th>File name</th>
<th>Viewable from</th>
<th>What it logs</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Server log</td>
<td>lmadmin.log</td>
<td>Server Configuration &gt; Logging</td>
<td>License Server, console, and administration activities</td>
</tr>
<tr>
<td>Vendor daemon log</td>
<td>citrix.log</td>
<td>Vendor Daemon Configuration &gt; Vendor Daemon Log</td>
<td>Licenses and license activities</td>
</tr>
<tr>
<td>Access log</td>
<td>access.log</td>
<td>logs folder</td>
<td>HTTP access events</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note:** This log is used by support personnel for debugging purposes only.</td>
</tr>
<tr>
<td>Web log</td>
<td>web.log</td>
<td>logs folder</td>
<td>Web server information</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note: This log is used by support personnel for debugging purposes only.</td>
</tr>
</tbody>
</table>

Some versions of the License Server (earlier than 11.6.1) included a report log. The License Administration Console does not include a report log. The legacy report log files are updated only when you relocate the file reportlog.rl to the logs directory and update the options file to control it.

C:\Program Files\Citrix\Licensing\LS\reportlog.rl for Windows

**To view and configure the License Server log**

1. In the Administration area, on the Server Configuration page, select the Logging bar.
2. Select View log file.
3. To change the level of logging, select the type of information to be recorded from the Log Level list. **Note:** Leave this property set to the default setting of Information unless support personnel instructs you to change it to aid in troubleshooting.
To view the vendor daemon log

This procedure displays the latest 200 lines of data in the file. You can view the entire contents of the log (citrix.log) by opening it directly from:

\Program Files\Citrix\Licensing\LS\Logs folder for Windows

1. In the Administration area, on the Vendor Daemon Configuration screen, select the Vendor Daemon Log bar.
2. Select View log file.

To configure the vendor daemon log

1. In the Administration area, on the Vendor Daemon Configuration page, select the Vendor Daemon Log bar.
2. Select whether to overwrite or append to the log:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwrite Vendor Daemon Log</td>
<td>When selected, this option overwrites the log when you restart the Citrix Licensing service or the vendor daemon. If the option is clear, the log entries are appended to the end of the file.</td>
</tr>
<tr>
<td>Vendor Daemon Log Location</td>
<td>We don’t recommend changing log location.</td>
</tr>
</tbody>
</table>

3. Select Save.
4. Select Stop under Vendor Daemon Actions.
5. Select Administer on the Vendor Daemon Configuration page and then Start under Vendor Daemon Actions.

Licensing alerts

Alerts appear on the Dashboard and are classified as critical or important. Administrators can select which alerts appear on the Dashboard and set the thresholds that trigger them.

1. In the top right corner of the console, select Administration and select the Alert Configuration tab.
2. Select the alerts you want to display on the Dashboard, and for the important alerts determine the threshold to trigger the alert.
3. Select Save.

4. By default, Customer Success Services membership alerts also appear on the Dashboard. To turn on or off these alerts:
   a) Select Vendor Daemon Configuration.
   b) Select the Citrix vendor daemon.
   c) Select or clear Enable Customer Success Services membership expiration alerts for this vendor daemon.

Important

Certain license types are not covered by Customer Success Services. They appear in alerts in the Dashboard of the License Administration Console. The alerts indicate that the Customer Success Services date is expired. You can ignore such alerts for any license not covered by Customer Success Services. These licenses include:

- Evaluation licenses
- Not for Resale licenses
- Preview licenses
- Technology Preview licenses.

These types of licenses do not need Customer Success Services and your Citrix products do not stop working when the Customer Success Services date is expired. You can verify the status of any license for which you receive an alert by clicking the license on the Dashboard. The license information expands to show the license type (such as Technology Preview), the license expiration date, and the Customer Success Services date.

License Server administration without a console

September 18, 2019

Note:

Citrix is working to improve the licensing experience in My Account on citrix.com. You can choose Manage Licenses to easily find, allocate, download, modify, return, hide, and unhide licenses. The legacy All Licensing Tools experience is still available for a limited time.

There are several administration procedures that you can do without using the Citrix Licensing Manager or the License Administration Console. We recommend that you use the appropriate console whenever possible. This article describes the procedures required if you are unable to use a console.

- Customer Success Services renewal files
- Delete license files
- Disable the domain name truncation on Windows
Licensing 11.16.3

- Register the License Server with Citrix Cloud

You can use the licensing management tool on citrix.com to combine, install, reallocate, and redownload licenses. For more information, see Manage Licenses at citrix.com My Account.

Customer Success Services

After you download your Customer Success Services renewal license file from citrix.com, you must add it to your License Server. Copy the Customer Success Services renewal license files to the same directory as your existing license files and reread the license files. By default, this location is C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server and C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit server. After you add the renewal license to your License Server, the license automatically unlocks any subsequent versions of the product released during the Customer Success Services period.

Renewing only part of your Customer Success Services membership:

If you run products from two different releases in your environment, and you are not purchasing Customer Success Services for all your licenses, we recommend that you separate the product licenses on two separate License Servers. For example, you have a mixed XenDesktop environment of versions 7.16 and 7.18. Customer Success Services is applied to the older product versions first.

Example:

You own 200 licenses for 7.16 and you renew your Customer Success Services membership for only 100 of those licenses. It is possible that connections to computers running 7.18 might consume those 100 renewal licenses, which are required for 7.16.

To separate your licenses (two different licenses on two different servers):

1. Select a second server and install the License Server software.
2. Go to citrix.com to reallocate your original licenses, and then reallocate the licenses into two new files. These original licenses are contained in your current license file on the original License Server.
   - Allocate licenses to your first License Server for your 7.16 deployment.
   - Allocate licenses to create another license file for the second License Server for your 7.18 deployment.
3. Generate and download your Customer Success Services files and then copy them to the server to which you want them applied.
4. Point all computers to the License Server running the version of the Citrix product you want them to use. For information about pointing your Citrix product server to the License Server, see your Citrix product’s administrator guide.
Delete license files

When you upgrade your edition (for example, Standard to Advanced, or Advanced to Premium) you receive new Citrix product licenses. You can allocate these licenses to one or many Citrix License Servers through license files created at citrix.com. Rescinded licenses must be deleted from License Servers within 90 days of new license purchase. Deleting the licenses enables:

- License asset management
- License compliance
- Delete unnecessary alerts from appearing in the management console

Considerations when deleting files:

- Incorrect removal of license files might inadvertently lower the total licenses available.
- Place any new license files on the License Server before deleting any licenses.
- Delete a license file only when all INCREMENT lines in the file are obsolete or unnecessary. For example, every increment line was replaced with a new license because of an upgrade.
- If you used the License Administration Console to add license files, you have to update the console UI for any deleted files.

Important

Never delete the options file (citrix.opt) or startup license (citrix_startup.lic).

1. At the License Server, open the Services panel and stop the Citrix Licensings service.
2. Open the Windows Explorer and navigate to where the license files are stored. By default license files are stored in:
   - C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit server
   - C:\Program Files(x86)\Citrix\Licensing\MyFiles on a 64-bit server
3. Back up all license (.lic) files.
4. Using a text editor (we recommend Microsoft WordPad), open each license (.lic) file and identify one or more obsolete license feature INCREMENT lines.
5. Ensure that all increment lines are obsolete or unnecessary. See License file format for information about increment lines.
6. Close the file and change the file name extension from .lic to .old.
7. In the Services panel, restart the Citrix Licensings service.

Disable the domain name truncation

Warning

Editing the registry incorrectly can cause serious problems that might require you to reinstall your operating system. Citrix cannot guarantee that problems resulting from the incorrect use of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
When you host multiple domains and multiple users who have the same user name on different domains, you can leave the domain name truncation enabled. For example, jack@mycompany.com and jack@newplace.com. If you have unique users on various domains, ensure that the License Server does not truncate @domain.com.

The License Server detects Citrix Service Provider licenses and enables this functionality.

1. Locate the registry key:
   - For 32-bit machines: HKLM\Software\citrix\licenseserver
   - For 64-bit machines: HKLM\Software\Wow6432Node\citrix\licenseserver
   Name: UDUseDomain

2. Set the registry key to 1.

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The domain field is truncated. (default)</td>
</tr>
<tr>
<td>1</td>
<td>The domain field is not truncated.</td>
</tr>
</tbody>
</table>

Use Manage Licenses in My Account on citrix.com

October 7, 2019

Note:
Citrix is working to improve the licensing experience in My Account on citrix.com. You can choose Manage Licenses to easily find, allocate, download, modify, return, hide, and unhide licenses.

The legacy All Licensing Tools experience is still available for a limited time.

There are several administration procedures that you can do without using the Citrix Licensing Manager or the License Administration Console. We recommend that you use the appropriate console whenever possible.

You can also use Manage Licenses at citrix.com. This article describes how to manage licenses on citrix.com.

For any of the following tasks, access the Manage Licenses section of your My Account page as follows:
To access Manage Licenses on citrix.com

2. Select Sign In > My Account and type your user ID and password.
3. Select Manage Licenses.

Allocate licenses

1. Select the licenses you want to allocate. The landing page displays only new licenses within 30 days and expiring term licenses. You can use the Filter by menu to search for specific types of licenses or select Quick find: All active to see all licenses.
2. From the Select an action menu, choose Allocate licenses.
3. Follow the process to allocate and generate your file.

Modify licenses

Modifying a license returns a single license file and allows for allocation to another server.

1. Select a product and click the link to view the product license details.
2. Select the allocated license to modify.
3. From the Select an action menu, choose Modify allocations.
4. Type a new server name.
5. Select Modify license file.
Download licenses

1. Select the licenses you want to download. The landing page displays only new licenses within 30 days and expiring term licenses. You can use the Filter by menu to search for specific types of licenses or select Quick find: All active to see all licenses.

2. From the Select an action menu, choose Download all licenses, and save the file to a temporary location. Remember the file name and location where you downloaded the file. You need this location.

3. At a command prompt, navigate to the folder and type the following command:

   lmreread -c @localhost -all

Hide and unhide licenses

Hiding licenses doesn't remove them from an account. When you hide licenses, it removes them from view.

1. Select the licenses you want to hide.

2. From the Select an action menu, choose Hide licenses.

3. To unhide licenses, choose Quick find: All hidden and select licenses.

4. From the Select an action menu, choose Unhide licenses.

Return licenses

Returning licenses puts them back in the licensing pool. These licenses can then be allocated in any quantity at any time.

1. Select the licenses you want to return.

2. From the Select an action menu, choose Return allocations.

Upgrade license edition

If you are eligible for a version upgrade as a benefit of your maintenance, you can obtain a new license and add it to the License Server.

1. At the bottom of the landing page, select Upgrade my licenses.

2. Follow the site options and instructions for upgrading your product edition licenses.

3. Either download or order new media. An email message provides you with instructions to return to citrix.com to allocate or receive more feature licenses.

4. Log on to www.citrix.com to allocate your licenses, generate a license file, download the license file to your License Server, and reread the file.
Manage multiple licenses

You can apply actions to multiple licenses at the same time. To successfully apply actions to multiple licenses, be aware of these considerations:

- You can apply certain actions only to licenses with the same attributes. For example, you can only allocate licenses that have the same binding type. An error message appears when you select licenses that are not compatible for the bulk action.

  The first license you select is what subsequent selections are compared to for compatibility.

- If you select licenses that can't have an action applied to all of them, some actions might be disabled or not displayed, and a message might appear. For example, if you select two licenses, one that has been allocated and one that has not, a message appears. The message states that the action can apply only to allocated licenses.

Install licenses

1. Choose Download license files, and save the file to a directory.

2. At the License Server, copy the license file from the directory where it was saved to the \myfiles\ directory.

   Ensure that the license file retains the lower case .lic file name extension. Some copy processes don’t recognize a file type for that extension and add a “.txt” file name extension during the copy. You can’t import license files that have the wrong file name extension.

   - C:\Program Files\Citrix\Licensing\MyFiles on a 32-bit computer
   - C:\Program Files (x86)\Citrix\Licensing\MyFiles on a 64-bit computer

3. At a command prompt, navigate to:

   - C:\Program Files\Citrix\Licensing\LS on a 32-bit computer
   - C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

   And type the following command: lmreread -c @localhost -all

Search for licenses

- In the Find a license by… menu, choose the search criterion, type the search text, and select Search.

  You can select Show advanced search options to further narrow down your search.
Filter licenses

Use the **Filter by** menu to narrow your list to expired licenses, new licenses, available allocations, or trial licenses.

- From the **Filter by** menu, choose how you want to filter your output.

Create a product license report

1. Select the licenses you want in the report.
2. Choose the Export to Excel (.CSV) link on the bottom of the screen.
3. Save the file.

Licensing commands

September 18, 2019

While the License Administration Console provides an easy method of accessing many licensing features, you can also perform licensing tasks using commands. You might use the license administration commands for advanced operations on the License Server that are not available in the console. Such operations include diagnosing check-out problems using **lmdiag**.

License administration commands are stored in:

- C:\Program Files\Citrix\Licensing\LS on a 32-bit computer
- C:\Program Files (x86)\Citrix\Licensing\LS on a 64-bit computer

Descriptions of the commands

- **lmadmin** — Provides licensing configuration. Use the License Administration Console for licensing configuration and administration tasks. Do not use **lmadmin**.
- **lmdiag** — Diagnoses license check-out problems.
- **lmdown** — Gracefully shuts down the License Manager and Citrix vendor daemons (disabled by default).
- **lmhostid** — Reports the host ID of the server on which Citrix Licensing is running.
- **lmreread** — Causes the License Manager daemon to reread the license file and start the Citrix vendor daemon.
- **lmstat** — Displays the status of a License Server.
Licensing 11.16.3

- **lmutil** — Displays a list of licensing utilities or executes other commands.
- **lmver** — Displays version information for the licensing binaries.
- **udadmin** — Displays all licensed users and devices and deletes specified licensed users and devices. This command applies to user/device licenses only. Specifying **udadmin -export** exports unprocessed user and device data. This data is used to calculate license use and is not a list of licenses in use. To get a list of licenses, specify **udadmin -list**.

**Format license commands**

 Formatting conventions for the license administration commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>A command or switch, such as lmstat.</td>
</tr>
<tr>
<td><strong>Italic</strong></td>
<td>Replace variables with a value. For example, in the expression: <strong>lmstat -c license_file_list</strong>. Before you run the command, replace license_file_list with the names of one or more license files.</td>
</tr>
<tr>
<td><strong>[Brackets]</strong></td>
<td>Brackets around text indicate the options that you can add to the command. It might indicate that text within the brackets must be replaced.</td>
</tr>
</tbody>
</table>

**Universal arguments**

 Valid arguments for most license administration commands:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-all</td>
<td>Applies the command to all the License Servers on the network.</td>
</tr>
</tbody>
</table>
### Argument Description

- **-c**  Lets you specify license files or License Server port and host name. If you specify the path without a license file name, the command applies to all the license files in the directory.
  - For a local host: `-c @localhost`
  - For a remote License Server: `-c @servername`
  - For a License Server in a cluster: `-c @clientaccesspointname`
  - For a specified path: `-c path`
  - For the names of one or more license files: `-c license_file_list`

You can enter more than one license file path by separating each path with a semicolon. Path names that include spaces must be enclosed in double quotes.

- **-h**  License handle, as reported by `lmstat -a`. The license handle is a number used to identify a specific checked out license.

- **-help**  Displays usage information and exits.

- **-s [server]**  If you don’t specify a `server`, this argument displays the status of all license files listed on the License Server or the license files on all the License Servers.

- **-verbose**  Displays a longer description for all errors found.

## Diagnose checkout problems (lmdiag)

The `lmdiag` command allows you to diagnose problems when a product cannot check out a license. In particular, you can test if your licenses are valid and if the License Server is running. When you run this command, it attempts to check out a license.

You can also use the `lmdiag` command to see if a specific type of license is working.

Example:

Run `lmdiag` on your Citrix Virtual Apps server Advanced edition licenses only. Specify `MPS\_ADV\_CCU` as an argument.
Licensing 11.16.3

Syntax:
```
ldmdiag -c license_file_list [-n] [feature[:keyword=value]]
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-c license_file_list</td>
<td>Diagnoses the specified files. You can also use: -c @localhost or -c @server-name</td>
</tr>
<tr>
<td>-n</td>
<td>Runs in non-interactive mode. lmdiag does not prompt for any input in this mode.</td>
</tr>
<tr>
<td>feature</td>
<td>Limits the feedback to the specified feature.</td>
</tr>
<tr>
<td>keyword=value</td>
<td>If a license file contains multiple lines for a particular feature, the result is limited to the line containing the text value. For example: lmdiag -c @localhost MPS_ENT_CCU: HOSTID=LICSERV01 attempts a checkout on the line with the host ID LICSERV01. Keyword is one of the following: VERSION, HOSTID, EXPDATE, KEY, VENDOR_STRING, ISSUER</td>
</tr>
</tbody>
</table>

If no feature is specified, lmdiag operates on all features in the license files in your list. The lmdiag command displays information about the license, then attempts to check out each license. When the checkout succeeds, lmdiag indicates that the checkout was successful. When the checkout fails, lmdiag gives you the reason for the failure. The lmdiag command tries to connect to each TCP/IP port on the License Server. It detects if the port number in the license file is incorrect. lmdiag lists each TCP/IP port number that is listening, and if -c license_file_list is specified, diagnoses the specified files.

The lmdiag command does not contact the computer running the Citrix product when it attempts to check out licenses. The lmdiag command indicates only if there are problems on the License Server. That is, your product cannot check out licenses because it is pointing to the wrong License Server, but lmdiag does not detect this problem. For example, a License Server that does not have licenses for that product on it. The lmdiag command reports that it can check out licenses when the Citrix product is pointing to the wrong License Server.

Stop daemons (lmdown)

The lmdown command shuts down the License Manager daemon and the Citrix vendor daemon on your License Server or all License Servers on your network. The lmdown command is disabled by default. To enable it:
1. Stop the license service.
3. Restart the License Server.

**Syntax:**

```
lmshutdown -c license_file_list [-vendor CITRIX] [-q] [-all]
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-c license_file_list or -c@localhost or -c@server</code></td>
<td>Use the specified license files. We always recommend specifying <code>-c license_file_list</code> with <code>lmshutdown</code>. You can also use: <code>-c @localhost</code> or <code>-c @server-name</code></td>
</tr>
<tr>
<td><code>-vendor CITRIX</code></td>
<td>Shut down only the Citrix vendor daemon. The License Manager daemon continues to run.</td>
</tr>
<tr>
<td><code>-q</code></td>
<td>Do not prompt or print a header. Otherwise, <code>lmshutdown</code> asks “Are you sure? [y/n]: ”</td>
</tr>
<tr>
<td><code>-all</code></td>
<td>If multiple servers are specified, automatically shuts down all of them. <code>-q</code> is implied with <code>-all</code>.</td>
</tr>
</tbody>
</table>

Run the `lmshutdown` command on a License Server. You can use `-all` to shut down all the License Servers on your network.

If `lmshutdown` encounters more than one server and you didn’t specify the `-all` argument, the command displays a choice of License Servers to shut down. For example, the `-c` argument specifies a directory with many `.lic` files. Shut down the remote License Servers by using `-c` and specifying the name of the License Server.

**Note:**
If you use the Task Manager to terminate the License Manager daemon (Citrix Licensing Service), stop the `lmgrd` process first, then stop the Citrix vendor daemon process.

To stop and restart the Citrix vendor daemon only, use `lmshutdown -c @localhost -vendor CITRIX`, then use `lmreread -c @localhost -vendor CITRIX` to restart the vendor daemon.

**Check host names (`lmhostid`)**

The `lmhostid` command returns the host ID of the License Server. You can use the command to check the host name of your License Server. You can open a license file and compare the host name in the...
license file to that of your License Server.

**Note**

Citrix Licensing, versions 11.5 and later for Windows allows you to display multiple host IDs if there are more than one host.

**Syntax:**

```
lmhostid -bindingidentifier
```

<table>
<thead>
<tr>
<th>Argument (bindingidentifier)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-ether</td>
<td>Used for product licenses that are tied to the MAC address of the appliance.</td>
</tr>
<tr>
<td>-internet</td>
<td>Used for Windows-based Citrix product software licenses that require a TCP/IP address.</td>
</tr>
<tr>
<td>-hostname</td>
<td>Used for Windows-based Citrix product software licenses that are tied to the host name of the License Server. <strong>Note:</strong> The parameter <code>hostname</code> is case-sensitive and must match your License Server name exactly.</td>
</tr>
</tbody>
</table>

**Reread license and options files (lmreread)**

The `lmreread` command causes the Citrix vendor daemon to reread changes to the license file and the options file. After rereading, the Citrix vendor daemon uses the new settings and licenses from then on.

You cannot use `lmreread` remotely; run it locally on the License Server.

**Syntax:**

```
lmreread -c license_file_list [-all] [-vendor CITRIX]
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-c @localhost or -c license_file_list</td>
<td>Use the specified license files.</td>
</tr>
<tr>
<td>-all</td>
<td>If more than one <code>lmgrd</code> is specified, this argument instructs all License Manager daemons to reread.</td>
</tr>
<tr>
<td>-vendor CITRIX</td>
<td>Specifies for the Citrix vendor daemon to be restarted.</td>
</tr>
</tbody>
</table>
Examples:

- lmreread -c @localhost [-all]
- lmreread -c @client\_access\_point\_name
- lmreread -c /opt/citrix/licensing/myfiles/CITRIX.lic -vendor CITRIX

Display the list of licensing utilities (lmutil)

The lmutil command displays a list of licensing utilities when used standalone. When you specify lmutil with another command, it executes that command.

Syntax:

```
lmutil
lmutil other_command
```

Examples:

- lmutil
  Displays all the licensing utilities.
- lmutil lmstat -c @localhost
  Executes the lmstat command.

Determine licensing status (lmstat)

The lmstat command helps you monitor the status of all network licensing activities and provides you with information about license checkouts, including:

- The product that checked out one or more licenses
- The checkout data
- The version of the license file
- The License Server name and port
- The date the license was checked out
- Information about the Citrix vendor daemon status and the license files

The lmstat command displays information that it receives from the License Server. The lmstat command displays only one use of the license, even if there are multiple connections sharing that license.

Syntax:

```
lmstat [-a] [-c license\_file\_list] [-f [feature]] [-i [feature]] [-s [server]] [-S [CITRIX]] [-t timeout\_value]
```
### Argument Description

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a</td>
<td>Displays all information.</td>
</tr>
<tr>
<td>-c @localhost or -c@server or -c license_file_list</td>
<td>Uses the specified license files.</td>
</tr>
<tr>
<td>-f [feature]</td>
<td>Displays the products using a feature (product license). If you don’t specify a feature, usage information for all features is displayed.</td>
</tr>
<tr>
<td>-i [feature]</td>
<td>If you don’t specify a feature, this argument displays information from the INCREMENT line for the specified feature (product license) or all features.</td>
</tr>
<tr>
<td>-s [server]</td>
<td>If you don’t specify a server, this argument displays the status of all license files listed on the License Server or the license files listed on all the License Servers.</td>
</tr>
<tr>
<td>-S [CITRIX]</td>
<td>Lists all product servers using the features (product licenses) served by the Citrix vendor daemon.</td>
</tr>
<tr>
<td>-t timeout_value</td>
<td>Sets connection timeout to timeout_value. This value limits the amount of time <code>lmstat</code> spends attempting to connect to the License Server.</td>
</tr>
</tbody>
</table>

The output from `lmstat -c@localhost -a` looks similar to this example. The lines in the example might break because of the screen space.

```
License Server status: 27000@localhost
License file(s) on localhost: C:\Program Files (x86)\Citrix\Licensing\MyFiles\citrix\_startup.lic:C:\Program Files (x86)\Citrix\Licensing\MyFiles\License.lic:
localhost: license server UP v11.15.0
Vendor daemon status (on LicenseServer):
    CITRIX: UP v11.15.0
Feature usage info:
```
The following represents a breakdown of the information contained in the MPS_ENT_CCU line of the `lmstat` output:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MPS</strong></td>
</tr>
<tr>
<td><strong>mps_server1</strong></td>
</tr>
<tr>
<td><strong>MPS</strong></td>
</tr>
</tbody>
</table>
Licensing 11.16.3

<table>
<thead>
<tr>
<th>license_server</th>
<th>server_host</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.16.3</td>
<td></td>
<td>Computer where the License Server is running.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>port</th>
<th>TCP/IP port where the License Server is running.</th>
</tr>
</thead>
<tbody>
<tr>
<td>27000</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>handle</th>
<th>License handle. The license handle is a number used to identify a specific checked out license.</th>
</tr>
</thead>
<tbody>
<tr>
<td>203</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>checkout_time</th>
<th>Time that this license was first checked out.</th>
</tr>
</thead>
<tbody>
<tr>
<td>start Wed 3/17 11:56</td>
<td></td>
</tr>
</tbody>
</table>

The command `lmstat -c@localhost -a` can potentially generate much network activity in systems that have many product licenses checked out.

You can use `lmstat -a` to verify license checkout data.

**Display versions of binaries (lmver)**

The `lmver` command displays version information for the licensing binaries, such as the command utilities. One exception is the `lmadmin` command. To display version information for the `lmadmin` command, use `lmadmin -version`.

**Syntax:**

`lmver binary`

**Example:**

`lmver lmdiag`

**Display or release licenses for users or devices (udadmin)**

`udadmin` displays the licensed users and devices and releases licenses for specified users and devices.

You can release a license for a user only when:

- The employee is no longer associated with the company.
- The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.
Caution:
Mass releases of licenses, before the automatic 90-day lease period, outside of the reasons highlighted earlier might violate the Citrix EULA. Before doing so, contact Citrix.

The `udadmin` command-line help displays usage information only in English, but you can use the command on non-English systems.

**Syntax:**

```
udadmin [-options] [-delete | -events | -export | -list | -times]
```

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-f feature name</code></td>
<td>When used with <code>-list</code> or <code>-delete</code>, displays or releases the license for only the user or device for the specified feature name.</td>
</tr>
<tr>
<td><code>-user user name</code></td>
<td>Releases the license for only the user specified by the user name.</td>
</tr>
<tr>
<td><code>-device device name</code></td>
<td>Releases the license for only the device specified by the device name.</td>
</tr>
<tr>
<td><code>-a</code></td>
<td>Lists all features and versions installed on the License Server.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-delete</code></td>
<td>Releases the license for one user, feature, or device at a time.</td>
</tr>
<tr>
<td><code>-events</code></td>
<td>Reports all events logged by the user/device licensing for each feature sorted in chronological order.</td>
</tr>
<tr>
<td><code>-export</code></td>
<td>Exports unprocessed user and device data into one .csv document. This data is used to calculate license use and is not a list of licenses in use. The first row is the column header. Feature and then user is the format. Every unique <code>(user,deviceId,versionRequested)</code> is reported on one line. Redundant licensing requests for the same <code>(user,deviceId,versionRequested)</code> are not displayed individually. The most recent request updates the timestamp.</td>
</tr>
<tr>
<td>Options</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>-list</td>
<td>Displays the users and devices with licenses and the time since the last update. If significant activity occurred within 15 minutes of the last report, the time to the next update appears. Specifying -list-times generates output containing a timestamp.</td>
</tr>
<tr>
<td>-times</td>
<td>Specifying -list-times generates output containing a timestamp.</td>
</tr>
<tr>
<td>No argument or ?</td>
<td>Displays usage information for the udadmin command.</td>
</tr>
</tbody>
</table>

Examples:

```
1 - udadmin -list -times
2
3 Usage data is 0 minutes old. Next update in 15 minutes.
4
5 Users:
6   u01.01 XDT\_ENT\_UD 2017.1201 (Thu Sep 14 13:41:07 2017)
7   u01.04 XDT\_ENT\_UD 2017.1201 (Thu Sep 14 13:41:07 2017)
8   .
9   .
10
11 Devices:
13   D01 XDT\_PLT\_UD 2017.1201 (Tue Sep 12 14:30:33 2017)
14 - udadmin -list -a
15
16 Lists all features, versions, counts of licenses, and the users and devices for each feature.
17
18 - udadmin -export
19
20 feature,userId,deviceId,deviceName,versionRequested,
```
Clustered License Servers

October 7, 2019

Cluster servers are groups of computers that are combined to increase availability, reliability, and scalability. Microsoft clustering functionality exists in:

- Windows Server 2019
- Windows Server 2016
- Windows Server 2012 R2

Clustering the License Server lets users continue working during failure situations without interrupting their access to critical applications. When the active node in a cluster-enabled License Server suffers from hardware failure, failover occurs automatically. Resources are available again in a few seconds.

A typical cluster configuration has, at a minimum, one active and one passive (backup) server. When the active server in a cluster fails, the ownership of the resources in the cluster are transferred to the backup (passive) server. Typically, users cannot detect when one server in a cluster fails over to another.

When the active node of a clustered License Server fails, there is no impact on users connected to the Citrix product. The product might briefly enter the licensing grace period and an event might be written in the product’s event log.

Important

If Citrix Licensing is installed in a clustered environment and Windows Firewall is enabled, connections can fail. Connecting remotely to the console or checking out licenses works until failover occurs in the cluster. Exception rules for CITRIX.exe and lmadmin.exe are created during the installation of Licensing, but do not work after a cluster failover. To work around this issue, create exceptions for Licensing components on the Exceptions tab of the Windows Firewall panel. Create an exception for each of the following ports:

- License Server port number is 27000
- Vendor daemon port number is 7279
• Management console web port is 8082
• Web Services for Licensing port is 8083

Citrix licensing in a cluster

Like most clusters, a private network is used to send heartbeats, commands, and state information between the nodes of the cluster. If the connection is interrupted, the nodes try to reconnect by the private network first, then the public network. The following diagram illustrates a cluster-enabled licensing deployment:

Communications in a clustered licensing environment:
Only one node can use the resources in a cluster at any given time. If you already deployed Citrix Licensing and you want to migrate your deployment to a cluster-enabled server, keep the following points in mind:

- Because you already generated license files that reference a specific server name, you must give the client access point the same name as the original License Server. If not, then rehost your license files with the new name of the License Server cluster.
- Host names in license files are case-sensitive; therefore, the client access point names must be the same case as the host names in the license file. If they are not, you must rehost your license files with the correct capitalization of the names. You can use the Failover Cluster Manager to
ensure that the client access point name matches the host name specified in the license file. Cluster and host name case is not an issue if you use Studio in XenDesktop or the Simple License Service (from the Start menu on your License Server) to download your licenses.

- Point all product installations (for example, servers running Citrix XenDesktop) serviced by the old License Server to the new License Server cluster. Change product communication settings so that they use the name of the client access point as the License Server name. For information about editing product-side communication settings, see the product’s documentation.

**Requirements for clustered License Servers**

The following list outlines the requirements for setting up a License Server in a Microsoft Cluster:

- Citrix Licensing does not support Clustered Shared Volumes or third party Volume Management products for clusters.
- Before configuring Citrix Licensing for Microsoft clustering, you must have a fully functional Microsoft cluster environment. Citrix Licensing Services runs on only one node at a time.
- To cluster the License Server, follow these cluster requirements in addition to any requirements from Microsoft for hardware and clustering in general.
- Install licensing on the cluster with the License Server installer CitrixLicensing.exe.
- When you install Citrix Licensing on a cluster, specify the name of the client access point. You are prompted for the name of the License Server during product installation.
- We recommend that you use identical License Server hardware for each node in the cluster. In particular, Citrix recommends two network adapters on each node and the servers have one drive configured as a shared drive.
- Ensure that each node has two network adapters. One for the connection to the public network and the other for the node-to-node private cluster network. We do not support using one network adapter for both connections.
- The public and the private IP address must be on different subnets because the Cluster Service recognizes only one network interface per subnet.
- A name resolution method, such as DNS, WINS, HOSTS, or LMHOSTS, is necessary to resolve the client access point name.
- Each server that forms the cluster must be in the same domain.
- Set static IP addresses for the private network connector.
- We recommend that you use the Citrix Licensing Manager to allocate licenses to the cluster.
- When you generate a license file at citrix.com, use the name of the client access point when prompted for the Host ID.
  - After you download a license file, copy it to the F:\Program Files\Citrix\Licensing\MyFiles folder (where F: is the shared drive for the cluster) on the License Server and reread it. Alternatively, use the License Administration Console to download, copy, and reread the file.
Important

Citrix recommends setting static IP addresses for all network adapters in the cluster, both private and public. If using Dynamic Host Configuration Protocol (DHCP) to obtain IP addresses, access to cluster nodes might become unavailable if the DHCP server goes down. If you must use DHCP for your public network adapter, use long lease periods to ensure that the dynamically assigned lease address remains valid even if the DHCP service is temporarily lost or perform a DHCP reservation.

Overview of the clustering process

The following steps describe the overall process involved in installing and configuring licensing on a cluster-enabled server. These steps assume you configured the clustering on the hardware on which you intend to install the License Server.

1. Create a cluster resource group. Assign a client access point and shared storage to the resource group. Ensure that the first node has control of the cluster resources and the resource group you created points to the first node.
2. On the first node of the cluster, start the Citrix Licensing installer, CitrixLicensing.exe, as an administrator. Install it on the first node to the shared cluster drive (not the quorum drive). Leave the Last Node in Cluster check box cleared.
3. Move the resources from the active node in the cluster to the second node.
4. Install the License Server on the second node to the same shared location as the first node. You can add more than two nodes to a cluster.
5. When installing the License Server on the last node in the cluster, ensure that you check the Last Node in Cluster check box.
6. Obtain license files that specify the client access point name of the License Server as the host name. After obtaining license files, you must add them to the License Server and then reread them.
7. Configure your Citrix product to use the client access point name—not the node name—of the License Server cluster.

Important

When a clustered License Server fails over, the cluster service renames the lmgrd_debug.log to the name of the node that previously hosted the services. Then it starts the services on the new active node and creates a lmgrd_debug.log.
**Clustered License Servers - install, upgrade, and uninstall**

September 18, 2019

**Important:**
The .msi does not support clustering. To install or upgrade for clustering, use `CitrixLicensing.exe`.

**Install licensing on a clustered-enabled server**

The following drive letters and paths/variables are used in this procedure:

- D is the drive for your product media.
- C is the local hard drive on the specified node.
- F is the cluster shared drive resource. (This drive is the installation drive. That is, the place where installation files used by each node are stored.)

**Important:**
- Because of a NetBios restriction, ensure that the client access point name is fewer than 15 characters.
- On non-English platforms, when starting a License Service installation on a cluster node, the Cluster Group list on the Configure screen might contain the system default Cluster Group. Select one of the non-default Cluster Groups and the installation continues normally.

1. Create a separate, noncore cluster resource group. The resource group must have the attached storage assigned a drive letter and a client access point. The client access point must have the same host name used when obtaining the license file. Use the Failover Cluster Manager and **Roles > Configure Role** in Windows Server 2012 R2, Windows Server 2016, and Windows Server 2019. Then select the **Other Server** type in the menu. Ensure that the first node of the cluster owns all cluster resources.

2. Run the License Server installer, `CitrixLicensing.exe`, as an administrator.

3. On the Install Location page, set the drive letter to correspond with the cluster shared drive. By default, the licensing components are installed in F:\Program Files\Citrix\Licensing.

4. Leave the Last Node in Cluster check box cleared during the installation on the first node.

5. Move the resources for the resource group you created in Step 1 to the second node.

6. In node 2 of the cluster, run `CitrixLicensing.exe` as an administrator.
7. Go back to Step 3. You can install more than two nodes on the cluster. You can install more than two nodes on the cluster. For each additional cluster, repeat Step 3.

8. When installing the License Server on the last node in the cluster, ensure that the Last node in the cluster check box is checked. The last node is where the ports are configured.

9. Use the Citrix Licensing Manager to import your license files. Otherwise, import your license files using the console and these steps. For more information, see Install licenses.
   a) Open the License Administration Console from http://client access point name:web service port. The client access point name is the name of the cluster. The web service port is the port number for the console Web server (8082 by default).
   b) Choose Administration and choose the Vendor Daemon Configuration tab.
   c) Choose Import License.
   d) Click the citrix.com link.
   e) On the My Account page, type your user ID and password.
   f) Choose Manage Licenses.
   g) Select the licenses you want to download. The landing page displays only new licenses within 30 days and expiring term licenses. You can use the Filter by menu to search for specific types of licenses or select Quick find: All active to see all licenses.
   h) From the Select an action menu, choose Download all licenses, and save generated license files to the shared drive of the cluster: F:\Program Files\Citrix\Licensing\MyFiles\.
   i) In the License Administration Console on the Import License File page, browse to the license file.
   j) Choose Overwrite License File on License Server.
   k) Choose Import License.

10. Reread the license files.
   a) Choose the Vendor Daemon Configuration tab.
   b) Choose Administer in the CITRIX vendor daemon line.
   c) Choose Reread License Files.

**Opening the console or running commands**

All licensing administration features available in standard deployments are also available on clustered License Servers. These features include the management console and the ability to run license administration commands.
Open the License Administration Console in a cluster by browsing to:

**https://*client access point name*:*web service port***

Where the **client access point name** is the name of the cluster and **web service port** is the port number for console communications. The default port number is 8082.

To specify the location of the license files in the cluster, you can run many license administration commands using the argument `-c @client access point name`. For example:

`lmreread -c @client access point name -all`

**Upgrade a clustered License Server**

If you are running a version of a License Server older than 11.12.1, uninstall it and then install this version. The older versions of the License Server do not conform to current Microsoft cluster guidelines. This version of the License Server has the functionality required to support Windows Server 2008 and greater.

**Uninstall a clustered License Server**

Uninstall licensing from a clustered License Server using the **Control Panel > Programs and Features** option from the active node.

Ensure that the first node contains all the resources.

1. From the first node in the cluster, start **Control Panel > Programs and Features**.
2. Remove Citrix Licensing.
3. Using the failover cluster manager, move the resources in the Citrix Licensing resource group to the second node.
4. Remove Citrix Licensing from the second node. If there are more nodes, repeat Steps 3 and 4 for each node, and then proceed to Step 5.
5. Remove the remaining files from the shared drive.

   Note: The uninstallation process does not remove the license files and options file from the shared drive.

For troubleshooting information, see **Troubleshoot**.

**License Server back up and redundancy**

September 18, 2019
Depending on how crucial the applications associated with your licenses are, you might want to create backup License Servers. Although Citrix stores backup copies of your licenses, downloading many replacement licenses can be time-consuming. If the License Server fails, you can store backup licenses on a network file share, or have a configured backup License Server ready.

**Redundancy solutions**

Setting up redundancy solutions might be necessary only in mission-critical environments. For smaller or less mission-critical deployments, you can back up your License Server by creating a duplicate License Server and store it on or off the network.

You can ensure redundancy for your mission-critical environments by:

- Creating a clustered License Server. For more information about clustering and licensing, see Setting up the License Server on a Microsoft Cluster.
- Using the high availability feature on XenServer minimum release version 5.6.
- Duplicating the License Server and its contents. Give the duplicate computer the same name as the active License Server and store it off the network.
- Storing another License Server that has a different server name on the network. In this case, when the active License Server fails, you must change the backup server name to start using it as the active License Server.
- Using a network appliance. If you are using only one License Server to service license requests at any time, you can use a network appliance that detects server or network outages and route traffic to a backup License Server.

All methods let you exchange one server license for another without a loss of service, provided the exchange occurs within the grace period. For more information, see “Grace periods” in Grace period.

Remember these key points:

- Because license files reference the server specified during allocation, you can use the files only on a server that has the same binding information. That is, the server name or FQDN or MAC address (possibly displayed on the portal as an Ethernet address) as the original License Server.
- You cannot have two License Servers that have the same name on your network active at the same time.
- Add any other licenses that you download to both the active License Server and the backup License Server.

**Troubleshoot the License Server**

September 18, 2019
Troubleshoot cluster-enabled License Servers

Important

If any of the licensing services fail to start, the cluster detects that licensing is offline and tries to restart the service three times (by default). When these attempts are unsuccessful, fail over to the next node begins. The cluster tries to start the services on the second node. When the attempts fail on the second server, the process might enter into an infinite loop. In this case, the computers running the Citrix products fall into the grace period. During the grace period, client connections are not affected.

When troubleshooting a cluster-enabled License Server, try the following:

- If you move the resources to the other node, do you still see the issue?
- If the installation fails, ensure that you don’t enable the User Account Control (UAC) when installing on a cluster.
- For Windows Server 2019, Windows Server 2016, and Windows Server 2012 R2:
  1. In the Failover Cluster Management window, from the left pane, select the cluster. In the middle pane, the summary information for the cluster appears.
  2. Select the Cluster Core Resources title to expand the section.
  3. Verify that the cluster resources are all online (green arrow).

Evaluation license warning message

After you replace the evaluation license files on the License Server with new license files, the Citrix product might display the following license expiration message when users log on: “Warning: The following Citrix Product is using an Evaluation license. This license will expire in...”

To resolve this issue:

1. Delete the old evaluation license files from the License Server. For more information, see Delete license files.
2. At the License Server, restart the Citrix Licensing service.
3. At the Citrix product server that needs license validation, point to a fictional License Server and then point the product back to the actual License Server. (See your product documentation for information about changing these settings.)
4. If the problem persists, restart the product server (for example, Delivery Controller).